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Preface

Preface

This preface contains the following sections:

e Documentation accessibility
e Diversity and Inclusion

* Related resources

e Access to Oracle Support

e Additional copyright information

Documentation accessibility

For information about Oracle's commitment to accessibility, visit the Oracle Accessibility
Program website at http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.

Diversity and Inclusion

Oracle is fully committed to diversity and inclusion. Oracle respects and values having a
diverse workforce that increases thought leadership and innovation. As part of our initiative to
build a more inclusive culture that positively impacts our employees, customers, and partners,
we are working to remove insensitive terms from our products and documentation. We are also
mindful of the necessity to maintain compatibility with our customers' existing technologies and
the need to ensure continuity of service as Oracle's offerings and industry standards evolve.
Because of these technical constraints, our effort to remove insensitive terms is ongoing and
will take time and external cooperation.

Related resources

All documentation and other supporting materials are available on the Oracle Help Center.

Access to Oracle Support

Oracle customers that have purchased support have access to electronic support through
Oracle Support Cloud.

Contact our Oracle Customer Support Services team by logging requests in one of the
following locations:

* English interface Customer Support Portal (https://hsgbu.custhelp.com/)
e Japanese interface Customer Support Portal (https://hsgbu-jp.custhelp.com/)

You can also call our 24x7 help desk. For information, visit https://www.oracle.com/life-
sciences/support/ or visit https://www.oracle.com/corporate/accessibility/learning-
support.html#support-tab if you are hearing impaired.
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This documentation may include references to materials, offerings, or products that were
previously offered by Phase Forward Inc. Certain materials, offerings, services, or products
may no longer be offered or provided. Oracle and its affiliates cannot be held responsible for
any such references should they appear in the text provided.
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Preparing to install

In this section:

Oracle InForm product archive

Oracle InForm software components
Determining resources for multiple studies
Configuring client computers

Performance Options setting in System Properties

Oracle InForm product archive

The Oracle InForm product archive includes zip archives that contain:

ORACLE

Native installers—The native installer archive contains setup files that install the base
products necessary for the Oracle InForm software to run.

Customization wizards—The customization wizard archives contain setup files you use to
apply customizations needed for an installation of the Reporting and Analysis module. Use
the customization wizard archives only if you are installing the Reporting and Analysis
module.

Archive Description

Oracle InForm Contains the Oracle InForm core software,
including the following features:
—  Oracle InForm Adapter

—  Oracle InForm Publisher
—  Oracle InForm Portal
— Lab Normals Management Tool (LNMT)

— Standard File-Based Integration (SFBI,
formerly known as IVRS)

# Note:

For on-premises installations, the
LNMT and SFBI modules are not
supported.

# Note:

For cloud-hosted installations, contact
Oracle Support to enable the LNMT
and SFBI features .
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Chapter 1
Oracle InForm software components

Archive Description

Cognos Analytics Customization for Oracle Contains files used to run the Cognos

InForm Customization for Oracle InForm wizard.
Cognos Analytics Gateway Customization for Contains files used to run the Cognos Gateway
Oracle InForm Customization for Oracle InForm wizard.

Oracle InForm software components

In this section:

e Overview of the Oracle InForm system architecture
* Application server options
» Database configuration options

*  Externally hosted studies

Overview of the Oracle InForm system architecture

The Oracle InForm software is a four-tiered software design. The following illustration is a
logical representation of the system architecture.

Tiers Software Components

; InForm Study URL InForm StudyURL InForm Study . InForm Study
Client Microsoft Edge Apple Safari URL Firefox URL Chrome

Web Cognos Gateway _

Application
Data
Oracle Instance i Oracle Instance
Tier Software component hosted Description
on the tier
Client Web browser Displays the pages of a study and

receives user input.

ORACLE’ 1o



ORACLE

Chapter 1
Oracle InForm software components

Tier

Software component hosted
on the tier

Description

Web

Web

Application

Application

Application

Application

Web server and gateway software
(MS-IIS)
Cognos Analytics Gateway

Oracle InForm application server

Cognos Report Server
(Application services)

Cognos Content Manager
(Content repository)

Oracle Directory Server

Services requests to and from the
web browser.

Manages the transfer of
information from the Web server
to another server. Provides
secure access to the Cognos
Analytics Server.

Logical server that acts as a
transaction manager for InForm
studies under the Oracle InForm
Service. The Oracle InForm
Server handles caching and
Microsoft Transaction Server
(MTS) packages. Each study is
associated with an Oracle InForm
study application server.

If the Reporting and Analysis is
installed, the Oracle InForm
Model Updater Service runs on
the Oracle InForm Server to
synchronize the clinical model.

Runs reporting-related requests
for operating system services.
There is one Cognos Analytics
Service per physical server
machine.

Manages the storage of customer
application data, including
security, configuration data,
models, metrics, report
specifications, and report output.
Content Manager is needed to
publish packages, retrieve or
store report specifications,
manage scheduling information,
and manage the Cognos
namespace.

Provides secure Admin access to
Oracle InForm Reporting.
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Application server options
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Oracle InForm software components

Tier Software component hosted Description
on the tier
Data Oracle database instances for: Oracle InForm study

database—Stores the study
components and the clinical
data. Studies typically share
an instance of the Oracle
database with the Oracle
InForm Admin schema.
Oracle InForm Admin
database—Used by the
Oracle InForm Service to
manage all the studies on a
physical machine. There is
one Oracle InForm Admin
database per Oracle InForm
Service.

Oracle InForm Reporting
database—Stores views for
Cognos Reporting through
the Reporting and Analysis
module. The Oracle InForm
Reporting database shares
an instance of the Oracle
database with the Oracle
InForm Admin and study
databases.

Cognos Analytics Content
Store—Stores user-created
reporting objects such as
folders, saved reports, and
saved views. The Content
Store can share an instance
of the Oracle database with
the Oracle InForm Admin
and study databases or can
reside in a separate Oracle
database instance.

You can distribute the software components across multiple application servers to best fit your

environment. You can use one of the following deployment options:

Minimal server deployment

Install the Oracle InForm software and the Reporting and Analysis module on the fewest

possible number of servers.

Multiple server deployment

Install the Oracle InForm software and the Reporting and Analysis module on multiple

servers.

Distributed server deployment
Install the Oracle InForm software and the Reporting and Analysis module on separate

servers.
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Oracle InForm software components

Minimal server deployment

Install the Oracle InForm software and the Reporting and Analysis module on the fewest
possible number of servers.

A minimal-server deployment requires the following servers:
e Oracle InForm Application Server
* A server that hosts the Cognos components and the Oracle Directory Server:
— Report application
— Content Manager
- Gateway
— Oracle Directory Server

« A server for all the database instances.

Multiple server deployment
Install the Oracle InForm software and the Reporting and Analysis module on multiple servers.

In a multiple server deployment, the Oracle InForm Server, the Cognos Analytics Server, and
the study and reporting databases are on at least five separate server machines that conform
to Oracle InForm hardware and software requirements.

For example, a multiple server deployment might include six server machines configured as
follows:

* One Cognos Gateway Server machine.
* One Cognos server machine containing the:
— Cognos Report server.
— Cognos Content Manager server.
e One Oracle InForm Application server machine.
e One Oracle Directory Server machine.
* Two dedicated Oracle database server machines:
— One for the Oracle InForm database and the reporting database.

— One for the Cognos Analytics Content Store.

# Note:

The Oracle InForm application server(s) and the Cognos Analytics application
server(s) must be in the same domain.

Distributed server deployment

Install the Oracle InForm software and the Reporting and Analysis module on separate
servers.

ORACLE e
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Oracle InForm software components

In a distributed server deployment, the Oracle InForm Application Server, the Cognos Report
Server, the Cognos Content Manager Server, the Cognos Gateway Server, the Oracle
Directory Server, and the study and reporting databases are on separate server machines that
conform to Oracle InForm hardware and software requirements.

For example, a distributed server deployment might include at least eight server machines
configured as follows:

e One Oracle InForm Application server machine.
*  One Cognos Gateway Server.
*  One Cognos Report Application Server.
*  One Cognos Content Manager Server.
e One Oracle Directory Server machine.
* Two dedicated Oracle database server machines:
— One for the Oracle InForm database instance and the reporting database instance.

— One for the Cognos Analytics Content Store database instance.

Database configuration options

You can use different configurations for your database instances when you install the Oracle
InForm software. You can choose:

« SameDB—Single database instance for Oracle InForm and Cognos reporting software
The Oracle InForm database and the Oracle InForm reporting database are installed on a
single database instance.

» Distributed deployment options
The database instance is configured to distribute tablespaces across multiple database
servers.

SameDB—Single database instance for Oracle InForm and Cognos reporting

software

The Oracle InForm database and the Oracle InForm reporting database are installed on a
single database instance.

Observe the following architecture rules when setting up the database instance for the Oracle
InForm software and the Reporting and Analysis module:

e Asingle database can hold multiple reporting schemas.

e The study and reporting schema cannot be installed in the same database as the Content
Store database for Cognos Analytics Reporting. No other Oracle products should already
reside in or be added to the study and reporting database.

* The Oracle InForm database is not required to run in archive log mode.

Distributed deployment options

ORACLE

The database instance is configured to distribute tablespaces across multiple database
servers.

You can distribute your study and reporting database across multiple disk partitions on the
same server or multiple database servers. For more information, see Multiple study
tablespaces.
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Determining resources for multiple studies

Externally hosted studies

Externally hosted studies must conform to the following requirements, or authentication issues
will result.

The Oracle InForm application server(s) and the Cognos Analytics application server(s)
must be in the same domain.

You must use the fully qualified domain hame to access the site.

Determining resources for multiple studies

You can install one or more studies on an Oracle InForm application server or on a physical
server. When deciding the load that you will place on a server, consider:

The number of Oracle InForm application servers on each physical server machine.
The number of studies on each Oracle InForm application server.

The size of the intended Oracle InForm application server (each server requires 40 to 50
megabytes of memory).

The number of studies you intend to run on the server machine.
The system availability requirements.

The geographic proximity of sites to the server.

Guidelines for determining resources

Sizing the server

Guidelines for determining resources

Follow these basic guidelines for determining resources:

Use separate server machines for production studies and studies that are used for testing
and training.

Consider using one server machine for multiple smaller studies (especially Phase 1
studies) that are on separate Oracle InForm application servers.

Use a separate server machine for each large study (especially Phase 3 studies). Although
multiple servers might require additional resources and additional cost, they also provide
increased dependability and stability.

Separate server machines can reduce risk. If you have more than one study on a server
machine and make an error in setup or configuration, all the studies on that server are
affected.

Sizing the server

ORACLE

When sizing an Oracle InForm application server, be aware of the resources that are already
being used. Make sure that you monitor the servers during the studies. When sizing your
server, consider the average number of:

Sites.
Subijects per site.
CRFs (forms).
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Configuring client computers

e Data items.

* Users.

For each study, consider the following:

e Good Clinical Practice (GCP) status of the study (GCP or non-GCP).
e Study phase.

e Study duration.

*  Enrolliment rate.

e Geographic proximity of servers to sites.
e System availability requirements.

*  Number of sites.

*  Number of users.

e Number of subjects.

e Number of unique forms.

e Maximum number of items per form.

e Average number of items per form.

e Maximum number of rules per form.

e Average number of rules per form.

e Total number of forms per subject.

Configuring client computers

In this section:

*  Browser settings for Microsoft Edge
e Browser settings for Google Chrome
e Browser settings for Apple Safari

*  Browser settings for Mozilla Firefox

* Windows Explorer settings

Browser settings for Microsoft Edge

If you are using Microsoft Edge, you can accept and use the default settings.

Browser settings for Google Chrome

Configure the following Google Chrome settings to access the Oracle InForm application.
Google Chrome is not supported for the Reporting and Analysis module.

«  Specify the preferred browser language.

e Configure pop-up blocking to allow pop-ups for the Oracle InForm web site domain and the
Reporting and Analysis web site domain.

e Prevent Chrome from using stored passwords.

ORACLE 18
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Performance Options setting in System Properties

e Setthe TLS option to use TLS 1.2 or higher.
*  Modify security settings to accept cookies.
e Set up tabbed browsing to launch links in a new tab.

For more information, see the Google Chrome documentation.

Browser settings for Apple Safari

Configure the following Apple Safari settings to access the Oracle InForm application.
Apple Safari is not supported for the Reporting and Analysis module.

*  Specify the preferred browser language.

*  Configure pop-up blocking to allow pop-ups for the Oracle InForm application web server.
e Prevent Safari from using automatic password completion.

*  Modify security settings to accept cookies.

e Set up tabbed browsing to launch links in a new tab.

For more information, see the Apple Safari documentation.

Browser settings for Mozilla Firefox

Configure the following Firefox settings to access Oracle InForm and Cognos.

»  Specify the preferred browser language.

»  Configure pop-up blocking to allow pop-ups for the Oracle InForm website domain and the
reporting website domain.

*  Prevent Firefox from using stored passwords.

e Set the security protocol option to use TLS 1.2 or higher.
*  Modify security settings to accept cookies.

e Set up tabbed browsing to launch links in a new tab.

For more information, see the Mozilla Firefox documentation.

Windows Explorer settings

Configure the following Windows Explorer settings to access the Oracle InForm application
and the Reporting and Analysis module.

*  Make sure the files with the XLS and XLSX extensions are not set to Browse in the same
window.

e Associate files with the XLS and XLSX extensions with the Microsoft Excel spreadsheet
software.

Performance Options setting in System Properties

ORACLE

If the Oracle InForm application server is also the database server for the study database
instance, you might receive errors that are related to cache initialization time when installing a
study if the system setting for Processor scheduling is not set to Adjust for best
performance of Programs.
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Performance Options setting in System Properties

On the Oracle InForm application and database server, open the System Properties
dialog box, and select Advanced.

In the Performance section, click Settings.
The Performance Options dialog box appears.
Click Advanced.

In the Processor scheduling section, click Programs.

# Note:

When the Oracle InForm application server and database server are different
machines, the system setting for Processor scheduling in the System
Properties > Performance Options dialog box should be the default value,
Background services.

Click OK in both dialog boxes.
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Installing the Oracle database software

In this section:

e About installing the Oracle database software

» Install the Oracle database software

About installing the Oracle database software

To install the Oracle database software, refer to your Oracle database documentation.

To ensure a successful installation, make sure your environment is set up correctly. For more
information, see the System Requirements guide for your Oracle InForm release.

Install the Oracle database software

You must install the Oracle database software on the:
e Oracle InForm database server.

e Cognos Content Store database server.

For more information:

e Steps to create database instances.

e Steps to create database users.

ORACLE
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Configuring the Oracle database software

In this section:

e About configuring the Oracle database software
* Create database instances

* Create database users

e Multiple study tablespaces

e Set up Transparent Database Encryption—Optional

About configuring the Oracle database software

To configure the Oracle database, you must create the:

« Database instances and tablespaces
For more information, see Create Oracle Database instances.

* Database users
For more information, see Create database users.

# Note:

This Oracle InForm release does not support the Oracle database multitenant
architecture with multiple pluggable databases (PDBSs) in a single container database
(CDB).

Create database instances

In this section:

e Steps to create database instances
e Create Oracle Database instances

e Set the initialization parameters for the database instances

Steps to create database instances

1. Create instances on the:

e Oracle InForm database server. If you are using the Reporting and Analysis module,
the Reporting database uses the Oracle InForm database instance.

e Cognos Content Store database server.
For more information, see:
*  Create Oracle Database instances

e Create a database instance for the Cognos Analytics content store
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2. Set the initialization parameters for the database instances on the Oracle InForm database
server.

For more information, see Set the initialization parameters for the database instances.

Create Oracle Database instances

Use the Oracle tools to create the instances required for your configuration.
Use the following character set specifications for the database instances:

 Database Character Set—AL32UTFS8.
¢ National Character Set—AL16UTF16.

To verify the character set settings:

1. Log into SQL*Plus and type:
sqlplus <dba userid>@<connection string>
When prompted, enter the dba user password.
2. Run the following command:

select * from nls database parameters
where parameter = any('NLS CHARACTERSET', 'NLS NCHAR CHARACTERSET');

«  Create the Oracle InForm User Management Tool database instance
* Create a database instance for the Cognos Analytics content store

e Set the minimum authentication protocol for connecting to the database instances

Create the Oracle InForm User Management Tool database instance

ORACLE

1. Setup an Oracle database instance.
2. Make sure the following instance DEFAULT tablespaces exist in the database instance:
*  SYSAUX

« SYSTEM

* UNDOTBS1
* USERS

- TEMP

Oracle InForm-specific tablespaces:
e TEMPBIG

* INFORM

« INFORM_LOB

3. Depending on your DB hardening, create specific tablespaces by running the following
SQL commands:

*  SQL commands for hardening DB
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INFORM

CREATE TABLESPACE INFORM DATAFILE '/uOl/oracle/oradata/triall/
inform0l.dbf' SIZE 1000M REUSE AUTOEXTEND ON NEXT 500M MAXSIZE
UNLIMITED ENCRYPTION DEFAULT STORAGE (ENCRYPT) BLOCKSIZE 16K;

INFORM_LOB
CREATE TABLESPACE INFORM LOB DATAFILE '/u0Ol/oracle/oradata/triall/

inform lob0l.dbf' SIZE 1000M REUSE AUTOEXTEND ON NEXT 500M MAXSIZE
UNLIMITED ENCRYPTION DEFAULT STORAGE (ENCRYPT) BLOCKSIZE 16K;

OR

e SQL commands for non-hardening DB

4

INFORM

CREATE TABLESPACE INFORM DATAFILE '/ulOl/oracle/oradata/triall/
inform0l.dbf"' SIZE 1000M REUSE AUTOEXTEND ON NEXT 500M MAXSIZE
UNLIMITED BLOCKSIZE 16K;

INFORM_LOB

CREATE TABLESPACE INFORM LOB DATAFILE '/uOl/oracle/oradata/triall/
inform lob0l.dbf' SIZE 1000M REUSE AUTOEXTEND ON NEXT 500M MAXSIZE
UNLIMITED BLOCKSIZE 16K;

Note:

Directory structure is provided as an example. Please make sure to match these
commands to the directory structure of your Oracle installation.

Note:

For pluggable databases (PBDs), you can create custom names for the study
database tablespaces. These custom names can follow any naming conventions
that suit your study. For example "STUDY1" and "STUDY1_LOB".

If only a single tablespace custom name is provided, then all large objects will be
placed in that tablespace along with regular objects.

If both tablespace custon names are provided, large objects will then be
automatically palced in the specified LOB tablespace.

If no custom names are needed, Oracle recommends using the default INFORM
and INFORM_LOB names.
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4. Create the TEMPBIG tablespace by running the SQL command:

CREATE BIGFILE TEMPORARY TABLESPACE TEMPBIG TEMPFILE '/u0Ol/oracle/oradata/
triall/tempbig.dbf' size 1000M reuse autoextend on next 500M;

Create a database instance for the Cognos Analytics content store

e Set up an Oracle database instance on the Content Store database server.

Set the minimum authentication protocol for connecting to the database instances

If you are installing Cognos Reporting, you must set the minimum authentication protocol
allowed when connecting to the database instances. Without this configuration, the Cognos

service does not start.

1. Locate the file sqglnet.ora on the database server. The default location of the file is
%ORACLE_HOME%\NETWORK\ADMIN. If the file does not exist, create it.

2. Add the following parameter to the file:
SQLNET.ALLOWED_LOGON_VERSION_SERVER=8

Set the initialization parameters for the database instances

When creating each Oracle InForm Oracle Instance, use the following initialization parameters

ORACLE

in the init.ora file.

Parameter

Production server values

Development server values

memory_target
(starting values)

db_block_size

db_files

open_cursors

See Note 1.

processes

See Note 1.
session_cached_cursors
See Note 4.
streams_pool_size
job_queue_processes

sessions

Small trial: 1.5 GB
Large trial: 10 GB
Mega trial: 25 GB

16384
Database dependent.
150

150 (or maximum number of
concurrent processes)

150

200M

5 minimum: 1 job for each study
(the job to update
PF_HEARTBEAT table every
minute in each study schema)
and 1 job for each propagation,
plus streams’ minimum
requirement of 2 and Oracle
MTS’s requirement of 1)

Up to 80% of memory available to
the Oracle database

16384
Database dependent.
150

50

150

200M

5 minimum: 1 job for each study
(the job to update
PF_HEARTBEAT table every
minute in each study schema)
and 1 job for each propagation,
plus streams’ minimum
requirement of 2 and Oracle
MTS'’s requirement of 1)

Derived: (1.1 * PROCESSES) + 5 Derived: (1.1 * PROCESSES) + 5
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Parameter

Production server values

Development server values

log_archive_dest

_job_queue_interval
filesystemio_options

See Note 3
workarea_size_policy

See Note 2.
parallel_max_servers
optimizer_adaptive_features

Recommended:
$ORADATA/ARCHIVE
Defaults:
$ORACLE_HOME/dbs
1

SETALL

auto

FALSE

Recommended:
$ORADATA/ARCHIVE
Defaults:
$ORACLE_HOME/dbs
1

SETALL

auto

FALSE

# Note:

These parameters might need to be adjusted depending on the demands on the
database that are created by the Oracle InForm application and Streams.

# Note:

Although AUTO is default, parameter is needed to ensure proper AMM functioning.

# Note:

Enables both direct I/0 and asynchronous 1/0O where possible.

# Note:

Up to the value of the open_cursors parameter.

Create database users

ORACLE

n this section:

Steps to create database users

Required Oracle InForm database accounts

Create a DBA user to use in the Oracle InForm User Management Tool installation

Create a user for the Cognos Analytics content store database

Create the PFCapAdmin user on the Content Store database server
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Steps to create database users

1. Create the Oracle InForm database users on the Oracle InForm database server.
For more information, see: Required Oracle InForm database accounts.

2. Create the Cognos PFCapAdmin and the Content database users on the Cognos Content
Store database server.

For more information, see:
» Create a user for the Cognos Analytics content store database.

e Create the PFCapAdmin user on the Content Store database server.

Required Oracle InForm database accounts

The following database accounts are required for each instance of the Oracle InForm Service:

e A DBA user for the Oracle InForm software. The default name of this user is pfdbadmin.

e A user that can connect to the Oracle InForm Admin database. The default name of this
user is informadmin.

The recommended way to create these accounts is to select the options to create them in the
Oracle InForm installation wizard. If you need to create either account at another time, you can

run a script.

Default account name Installation wizard checkbox Script and where to get
information

pfdbadmin Prep Oracle informprepora

For more information, see Step 2:
Install the Oracle InForm core
software on the InForm
Application Server.

informadmin Install Admin DB AdminDBWithDDL

For more information, see Step 2:
Install the Oracle InForm core
software on the InForm
Application Server.

In a multiple server installation of the Oracle InForm software, you create the pfdbadmin and
informadmin accounts on each server where you install the Oracle InForm software.

# Note:

You need to create the pfadmin user only one time per database instance. Therefore,
if you uninstall and reinstall the Oracle InForm software in the same database
instance, you can leave the Prep Oracle checkbox deselected during the second
installation.
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Create a DBA user to use in the Oracle InForm User Management Tool

installation

ORACLE

Create a DBA user and grant the user these privileges:

CREATE USER, ALTER USER, DROP USER WITH ADMIN OPTION
ALTER SYSTEM

CONNECT, RESOURCE WITH ADMIN OPTION
UNLIMITED TABLESPACE WITH ADMIN OPTION
CREATE TABLESPACE

ALTER TABLESPACE

DROP TABLESPACE

CREATE TABLE WITH ADMIN OPTION

QUERY REWRITE WITH ADMIN OPTION

CREATE SYNONYM WITH ADMIN OPTION

ADMINISTER DATABASE TRIGGER WITH ADMIN OPTION
CREATE TRIGGER WITH ADMIN OPTION

CREATE TYPE WITH ADMIN OPTION

CREATE VIEW WITH ADMIN OPTION

ANALYZE ANY WITH ADMIN OPTION

ANALYZE ANY DICTIONARY WITH ADMIN OPTION
CREATE ANY DIRECTORY WITH ADMIN OPTION

DROP ANY DIRECTORY WITH ADMIN OPTION
EXP_FULL_DATABASE

IMP_FULL_DATABASE

EXECUTE ON DBMS_DATAPUMP WITH GRANT OPTION
AQ_ADMINISTRATOR_ROLE WITH ADMIN OPTION
AQ_USER_ROLE WITH ADMIN OPTION

EXECUTE ON DBMS_AQADM WITH GRANT OPTION
EXECUTE ON DBMS_AQ WITH GRANT OPTION
EXECUTE ON SYS.DBMS_LOCK WITH GRANT OPTION
SELECT ON V_$DATABASE WITH GRANT OPTION
SELECT ON ALL_USERS WITH GRANT OPTION
SELECT ON ALL_TAB_PRIVS WITH GRANT OPTION
SELECT ON ALL_TAB_COLUMNS WITH GRANT OPTION
SELECT ON ALL_SOURCE WITH GRANT OPTION
SELECT ON ALL_DB_LINKS WITH GRANT OPTION
SELECT ON DBA_TABLESPACES WITH GRANT OPTION
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SELECT ON DBA_TABLES WITH GRANT OPTION

SELECT ON DBA_INDEXES WITH GRANT OPTION
EXECUTE ON SYS.UTL_RECOMP WITH GRANT OPTION
EXECUTE ON UTL_HTTP WITH GRANT OPTION

EXECUTE ON UTL_TCP WITH GRANT OPTION

EXECUTE ON UTL_SMTP WITH GRANT OPTION

EXECUTE ON UTL_URL WITH GRANT OPTION

EXECUTE ON DBMS_RANDOM WITH GRANT OPTION
EXECUTE ON DBMS_OBFUSCATION_TOOLKIT WITH GRANT OPTION
EXECUTE ON SYS.DBMS_SQL WITH GRANT OPTION
EXECUTE ON SYS.DBMS_LOB WITH GRANT OPTION
EXECUTE ON SYS.UTL_FILE WITH GRANT OPTION
EXECUTE ON SYS.DBMS_JOB WITH GRANT OPTION
CREATE PROFILE

CREATE MATERIALIZED VIEW WITH ADMIN OPTION
CREATE PROCEDURE WITH ADMIN OPTION

EXECUTE ON SYS.ORA12C_STRONG_VERIFY_FUNCTION
EXECUTE ON SYS.DBMS_RANDOM

2. Validate the database connection:

sqlplus <created DBA user>@<tnsnames_alias>

At the prompt, enter the content user password.

If the test is successful, a SQL prompt appears, showing that you have logged on to the
database server. An unsuccessful test generates an ORA- error. Consult your database
administrator for help in troubleshooting errors.

Create a user for the Cognos Analytics content store database

1. \Verify that the character set for the content store database is Unicode.

2. Create a user and grant the user these roles and privileges:

ORACLE

Roles

— CONNECT

— RESOURCE

— DEFAULT ROLE ALL

# Note:

The RESOURCE role is deprecated and may not be available in future
Oracle Database releases.

Privileges
— GRANT UNLIMITED TABLESPACE
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— GRANT CREATE VIEW

# Note:

For more information on suggested settings for creating the content store in
Oracle, please review the IBM Cognos documentation.

Validate the database connection from the Cognos Analytics server by typing:

sqlplus <contentuser_userid>@<tnsnames_alias>

At the prompt, enter the content user password.

If the test is successful, a SQL prompt appears, showing that you have logged on to the
database server as the content store database user. An unsuccessful test generates an
ORA- error. Consult your database administrator for help in troubleshooting errors.

Create the PFCapAdmin user on the Content Store database server

1.

Create the user PFCapAdmin on the Content Store database server and grant the user
these roles and privileges:

* Roles
— CONNECT
— RESOURCE

Run the create_cap_table.sql script (located in the
<Installation_Directory>\InForm\bin\DBOra\Reporting folder) to create a table called
TRIAL_URLS within this user/schema.

For more information, see create_cap_table.sql.

# Note:

The CAP schema can reside in the content store database instance or a
separate database instance.

Validate the database connection by running the following command from the Cognos
Analytics server or the Oracle InForm application server:

sqlplus <contentuser userid>@<connection string>

When prompted, enter the content user password.

If the test is successful, a SQL prompt appears, showing that you have logged on to the
database server as the PFCapAdmin user. An unsuccessful test generates an ORA- error.
Consult your database administrator for help in troubleshooting errors.

Multiple study tablespaces

By default, all study objects are created in the INFORM tablespace. In a production
environment, you should distribute each study across multiple tablespaces for improved
performance and for maintenance and monitoring. Before you install your study on a
production server, set up the study-specific tablespaces.

ORACLE
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The following table lists the Oracle table and index tablespaces to create, along with the
required parameters. All tablespaces should be locally managed.

# Note:

When creating the study tablespaces, use the names listed in the following table.

Table tablespace Index tablespace Size (MB)

%STUDY_NAME%_REF %STUDY_NAME%_REF_IDX 120

%STUDY_NAME%_ HIGH_TXN1 %STUDY NAME% HIGH TXN1 300
_IDX

%STUDY_NAME%_HIGH_TXN2 %STUDY_NAME%_HIGH_TXN2 500
_IDX

%STUDY_NAME%_HIGH_TXN3 %STUDY NAME% HIGH_TXN3 600
_DX

%STUDY_NAME%_HIGH_TXN4 %STUDY_NAME%_HIGH_TXN4 500
_IDX

%STUDY_NAME%_TXN %STUDY _NAME%_TXN_IDX 250

The remaining syntax for each of these tablespaces is:

CREATE TABLESPACE TABLESPACE NAME

DATAFILE ‘<path to data file>' SIZE <initial size>
AUTOEXTEND ON NEXT <file increment>

EXTENT MANAGEMENT LOCAL AUTOALLOCATE;

¢ Note:

The STUDY_NAME portion of the tablespace name must conform to Oracle
database name standards. It cannot start with a numeric character and cannot
contain special characters. Additionally, because the Oracle database has an internal
limit of 30 characters for a tablespace name, the study name must be 16 characters
or fewer.

Oracle provides sample configurations for distributing your tablespaces using from one to five
disks.

e Distributed Oracle InForm study tablespaces
e Creating the INFORM_LOB tablespace

Distributed Oracle InForm study tablespaces

ORACLE

In a production environment, Oracle recommends distributing tablespaces across multiple
disks. The table in this topic presents a suggested model for Microsoft Windows database
servers. For Linux database servers, the disk and partition names would follow the naming
conventions for those environments.
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In each configuration, it is recommended that you use the C: partition for the operating system
and distribute the database and application components across the remaining partitions.
Monitor your system to determine the optimal configuration.

e C:and D: are partitions on one disk.

 INFORM, SYSTEM, TEMPBIG are tablespaces.

¢ Note:
TEMPBIG is the default temporary tablespace of BIGFILE type for the Oracle InForm
application.
Physical 0 N/A 1 2 3 4
disks
Logical C: D: E: F: G: H:
disks
1 disk Windows Oracle N/A N/A N/A N/A
2012 INFORM
SYSTEM
Study Tables
Study
Indexes
TEMPBIG
Redo logs
UNDOTBS
Archive logs
2 disks Windows Oracle Study N/A N/A N/A
2012 INEFORM Indexes
Study Tables Redo logs
Redo logs UNDOTBS
Archive logs
3 disks Windows Oracle Study Study Tables N/A N/A
2012 INEFORM Indexes
Redo logs Redo logs
UNDOTBS
Archive logs
4 disks Windows Oracle TEMPBIG Study Tables Study N/A
2012 INFORM Redo logs Indexes
SYSTEM UNDOTBS
Redo logs Archive logs
5 disks Windows Oracle INFORM Study Tables Study TEMPBIG
2012 INFORM Redo logs Indexes Archive logs
SYSTEM UNDOTBS
Redo logs

ORACLE
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Creating the INFORM_LOB tablespace

To create the INFORM_LOB tablespace, use the following syntax:

CREATE TABLESPACE INFORM LOB

DATAFILE ‘<path to data file>' SIZE <initial size>
AUTOEXTEND ON NEXT <file increment>

EXTENT MANAGEMENT LOCAL AUTOALLOCATE;

Tablespace name Initial sizel autoextend File extent sizelfile Comments
size needed maximum size
INFORM_LOB 200M Make the initial size 200 This tablespace is used
megabytes, set to hold large objects.

AUTOEXTEND on and
set MAXSIZE to
UNLIMITED.

Set up Transparent Database Encryption—Optional

For data-at-rest encryption, Oracle recommends and supports Transparent Data Encryption
(TDE) on the database, which may require additional licensing fees.

For more information, see the Oracle Advanced Security Transparent Data Encryption (TDE)
FAQ.
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Installing and configuring the Oracle database

client

In this section:

Steps to install and configure the Oracle database client

Register the Oracle.DataAccess.dll assembly

Update the National Language Support registry settings on the Oracle database client

Configure the database connection

Validate the database connection

Steps to install and configure the Oracle database client

Make sure the correct version of Microsoft .NET Framework is installed on all the
computers where the Oracle database client will be installed.

ORACLE

1.

For more information, see the System Requirements guide.

Download the appropriate Oracle Database client for your environment from the Oracle
Database download website:

Oracle Database 19c Client (19.3) for Microsoft Windows x64 (64-bit)
— WINDOWS.X64_193000_client.zip

Oracle Database 19c Client (19.3) for Microsoft Windows (32-bit)

— NT_193000_client.zip

# Note:

Be sure to apply the appropriate Oracle client patches required for the Oracle
InForm application servers. For more information, see the System Requirements
guide.

Install the Oracle database client on the:

Oracle InForm Application Server

Cognos Content Manager Server

Cognos Report Server

When prompted by the Select Installation Type dialog box, select Custom.

In the Available Product Components dialog box,select the appropriate components
for the Oracle InForm application. For more information, see the System Requirements
guide.
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# Note:

The Cognos Content Manager Server and Cognos Report Server require the 32-
bit version of the Oracle database client.

For more information, see your Oracle database documentation.

4. Register the ODP.NET assembly to the GAC on each server where you installed the
Oracle database client.

For more information, see Register the Oracle.DataAccess.dll assembly.
5. Update the registry settings on each server where you installed the Oracle database client.

For more information, see Update the National Language Support registry settings on the
Oracle database client.

6. Configure the database connection.
For more information, see Configure the database connection.
7. Validate the database connection.

For more information, see Validate the database connection.

Register the Oracle.DataAccess.dll assembly

You must register the Oracle.DataAccess.dll assembly to the Global Assembly Cache (GAC)
for .NET version 4:

1. Open acommand prompt as an Administrator.
2. Seta value for ORACLE_CLIENT_HOME if it is not defined.

For example, set ORACLE_CLIENT_HOME=C:\app\oracle\product\19c\client_1
3. Navigate to %ORACLE_CLIENT_HOME%\ODP.NET\bin\4

4. Execute the following commands:

OraProvCfg.exe/action:config /force /product:odp /
frameworkversion:v4.0.30319 /providerpath:Oracle.DataAccess.dll
OraProvCfg.exe /action:config /force /product:odp /
frameworkversion:v4.0.30319 /providerpath:%ORACLE CLIENT HOME%
\odp.net\bin\4\Oracle.DataAccess.dll

OraProvCfg.exe /action:gac /providerpath:%ORACLE CLIENT HOMES
\odp.net\bin\4\Oracle.DataAccess.dll

OraProvCfg.exe /action:gac /providerpath:%ORACLE CLIENT HOME%
\odp.net\PublisherPolicy\4\Policy.4.112.0racle.DataAccess.dll
OraProvCfg.exe /action:gac /providerpath:%ORACLE CLIENT HOMES
\odp.net\PublisherPolicy\4\Policy.4.121.0racle.DataAccess.dll
OraProvCfg.exe /action:gac /providerpath:%ORACLE CLIENT HOMES
\odp.net\PublisherPolicy\4\Policy.4.122.0racle.DataAccess.dll
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Update the National Language Support registry settings on the
Oracle database client

The following registry settings are required for the Oracle client home on the Oracle InForm
Application Server, the Cognos Report Server, and the Cognos Content Manager Server.

The entries are in the following Windows Registry key:

HKEY LOCAL MACHINE\SOFTWARE\ORACLE\<Oracle client home key>

Option Value
NLS_LANG American_America.AL32UTF8
NLS SORT JAPANESE M

Configure the database connection

To configure the Oracle client on the Oracle InForm Application Server, the Cognos Report
Server, and the Cognos Content Manager Server to connect with the database server:

Update the thsnames.ora file located on the application server so that it contains the alias
that is used to establish a connection to the database server.

# Note:

When installing the Oracle InForm software, you enter the alias specified in the
tnsnames.ora file as the database connect string.

Validate the database connection

To validate the database connection from the Oracle InForm Application Server, the Cognos
Report Server, and the Cognos Content Manager Server

e Type the following command at the Windows command prompt:

sqlplus pfdbadmin userID@tnsnames alias

When prompted, enter the pfdbadmin password.
The default user name for the pfdbadmin database account is pfdbadmin.

If the test is successful, a SQL prompt appears, showing that you have logged on to the
database server as the pfdbadmin user. An unsuccessful test generates an ORA- error.
Consult your database administrator for help in troubleshooting errors.
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# Note:

Problems with connections can sometimes be attributed to the database server that
contains a single Ethernet card with two nodes. Disabling one of the ports from the
card usually solves the problem. Consult your system administrator for help in
resolving errors.
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Preparing the application servers

In this chapter:

Preparing the Oracle InForm Application Server
Preparing the Reporting application servers

Enable Secure Sockets Layer (SSL)
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Preparing the Oracle InForm Application
Server

In this section:

e Steps to prepare the Oracle InForm Application Server
e Set up Oracle InForm Adapter

e Set up Oracle InForm Publisher

e Install the sample study

e Qualify the installation

Steps to prepare the Oracle InForm Application Server

All InForm installations use an Oracle InForm Application Server.
To prepare the Oracle InForm Application Server:

» Step 1: Verify the Oracle database client on the Oracle InForm Application Server
e Step 2: Install the Oracle InForm core software on the InForm Application Server
e Step 3: Set up a skeletal study

*  Step 4: Install the Oracle Central Designer certificate

*  Step 5: Update the DomainSuffix entry for the AuthenticationFilter registry key on the
Oracle InForm Application Server—Optional

* Step 6: Enable SSL on the Oracle InForm Application Server—Optional
e Step 7: Create a sending address for automated study deployment confirmation messages

*  Step 8: Enable network access rights for automated study deployments

Step 1. Verify the Oracle database client on the Oracle InForm Application
Server

Before you begin, ensure that you have followed the instructions in Installing and configuring
the Oracle database client to make sure the following requirements are met on the Oracle
InForm Application Server:

e The Oracle database client is installed.
e The language registry settings are updated.

* The database connection is configured and verified.

Step 2: Install the Oracle InForm core software on the InForm Application
Server

You install the Oracle InForm core software on the Oracle InForm Application Server only.
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Verify you have installed the correct components required for the Oracle InForm
Application Server, such as IIS components or the Java Runtime Environment.

For more information, see the System Requirements guide.
Log in to the application server as an administrator.

Download and extract the Oracle InForm product archive from the Oracle Download
Center.

Navigate to the location of the installation files, and double-click setup.exe.
The Choose Setup Language page appears.

Select either English or Japanese for the language that you want the wizard to use during
the installation.

# Note:

Configuration of the language used for application pages occurs later in the
installation.
Click Next.

The Preparing Setup progress page appears. When setup is complete, the Welcome page
appears.

Click Next.
The Choose Destination Location page appears.
Accept the default location, or click Change and browse to the desired location.
Click Next.
The Setup Type page appears.
Choose one of the following options, and click Next.
e Complete—Installs all the application components:
— Oracle InForm
— Oracle InForm Adapter
— Oracle InForm Publisher
— Standard File-Based Integration (SFBI)
— Lab Normals Manaagement Tool (LNMT)
— Data Export
— Data Import
— Performance Monitor
— Oracle InForm Portal
— Reporting Configuration
e Custom—Allows you to opt out of installing Reporting Configuration.
If you select Complete, the Select Product Locale page appears.

If you select Custom, the Select Features page appears. Make your choices and click
Next. The Select Product Locale page appears.

Select either English or Japanese for the Product Locale for the installation.

5-2



ORACLE

12.

13.
14.

15.
16.

17.

Chapter 5
Steps to prepare the Oracle InForm Application Server

This determines the language in which the Oracle InForm application pages appear after
installation.

Click Next.

The Select the Authentication Scheme page appears.
Select Native Authentication.

Click Next.

The Select the Oracle Home for Oracle InForm page appears. The Oracle Homes you
configured during your Oracle client installation appear on the page with the prefix KEY_ to
indicate the Windows registry key.

Select the entry for the Client Oracle Home registry key.
Click Next.
The Database Configuration page appears.

Enter values or accept the defaults for the configuration fields, and click Next.

Field Description
Local Machine User The name of the local machine user. The default
is pfUSR_<machinename>.
Local Machine User Password The password for the local machine user.
# Note:

The password for the local machine
user must comply with the password
requirements defined in your domain
password policy.

Database Connection String String that the Oracle InForm server uses to
connect to the Oracle instance for the study.
Oracle DBA User The name of the Oracle account created during

the Oracle database installation process. This
value is only used if you select the Prep Oracle
checkbox to create the pfdbadmin account.

# Note:

Do not use DB users with the sysdba
role, as this will cause the InForm
installation to fail.

Oracle DBA Password Password of the Oracle account created during
the Oracle database installation process. This
value is used only if you select the Prep Oracle
checkbox to create the pfdbadmin account.

Admin Database Username User name that is required to access the Admin
database.
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Field

Description

Admin Database Password

Password that is required to access the Admin
database. The password is case-sensitive. Do
not include a hyphen (-) character in the
password.

The password must comply with the
requirements of the complexity verification
function configured for the database.

InForm System Username

User name for the study database. If this is a
new Oracle InForm installation or if you change
the user name from the default during the
installation, select the Prep Oracle checkbox.
This instructs the Oracle InForm software
installation to create the Oracle InForm account
using the user name and password you specify.

InForm System Password

Password for the study database user. The
password is case-sensitive. Do not include a
hyphen (-) character in the password.

The password must comply with the
requirements of the complexity verification
function configured for the database.

Install Admin DB

If selected, creates the:

. informadmin user, using the Admin
Database Username and Admin Database
Password.

e Oracle InForm Admin database for non-
clinical data, such as users, sites, and
configuration information.

# Note:

You must select this checkbox for both
installation and upgrades.

Prep Oracle

If selected:

*  Runs the informprepora command, which
creates the study database user, using the
Oracle InForm System Username and
InForm System Password.

If not selected:

e Verifies the study database user and
password.

# Note:

You need to select the Prep Oracle
checkbox only the first time you install
the InForm software on an instance.

If any of the information is incorrect (for example, the Database Connection String), a
Database Configuration Error window appears.

ORACLE
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If the Database Configuration Error window appears, click Back to return to the Database
Configuration page to fix the incorrect information, and click Next when changes are
complete.

The Ready to Install the Program page appears.

The installation checks both the .NET framework and ODAC, and if an upgraded version is
required, a message appears.

If you need to upgrade the .NET framework or ODAC, click Cancel to make the necessary
corrections, and click Yes when the Exit Setup dialog box appears.

If you exited the installation at the previous step, upgrade the .NET framework or ODAC
version, and restart the installation wizard.

Click Install.
The Setup Status page appears. The progress of the installation is indicated on the screen.

If your system does not have the required hardware or software components, the
Requirements Not Met message appears. Click Cancel to make the necessary
corrections, and click Yes when the Exit Setup dialog box appears.

If you exited the installation at the previous step, update the server with the required
hardware or software components, and restart the installation wizard.

When the setup is finished, the Oracle InForm Reboot page may appear.

Select Yes or No to indicate whether you want to reboot at this time, and click Finish.
After rebooting, the final configuration process continues.

When the system configuration is finished, click Finish on the InstallShield Wizard
Complete page.

If any errors occur during installation, the default location where error logs are saved is
C:\Program Files (x86)\Oracle HS \InForm<release>\InForm
<release>.<build_number>\InstallLogs. The file name for the error logs is Install_yyyy-mm-
dd_hh-mm-ss.log.

Step 3: Set up a skeletal study

Before you can deploy a study, you must set up the basic framework to hold your study design
and data. This framework is called a skeletal study. All the commands used to create the
skeletal study are run from a Windows command prompt.

The following procedure sets up a skeletal study named pfst on the server demo.

ORACLE

1.

Create the Oracle InForm server that will host your studies:
pfadmin setup server demo

Create a study within your server:

pfadmin setup trial pfst demo /db TRIALL

When prompted enter the:

e Study DB user ID.

* Password to associate with the study user. The password must comply with the
requirements of the complexity verification function configured for the database.

This command creates your study, and associates it with a database instance.
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Set up the Oracle InForm application for your study:

dbsetup pfst base

This command installs the components of the Oracle InForm application for your study.

Copy the Oracle InForm folder from the Oracle Central Designer image to the Oracle
InForm application server.

Run InstallCentralDesignerFiles.cmd, located in the Oracle Central Designer image
Oracle InForm folder.

The InstallCentralDesignerFiles command installs and registers the Oracle Central
Designer rules engine, as well as other files the Oracle InForm application uses for
automated deployments.

# Note:

You only need to run the InstallCentralDesignerFiles command one time on the
Oracle InForm application server. After the Oracle Central Designer rules engine
is installed, it can be used by all the Oracle InForm studies on the server.

Specify a TrialType for your study:

pfadmin config trial pfst /TrialType QA

The TrialType options are:

e Live—Production environment.

« UAT—User acceptance environment.

¢ QA—Product test environment.

*  TRN—Training environment.

e Dev—Product development environment.

For automated deployments to work, the TrialType must be the same as the deployment
instance type set in Oracle Central Designer.

Specify whether your study requires approvals from the Oracle Central Designer
application in order to autodeploy a study deployment package.

pfadmin config trial pfst /TrialApproval FALSE

The TrialApproval options are:
e True—Approvals required.

e False—Approvals not required.

# Note:

In order to deploy a deployment package from within the Oracle InForm user
interface, the TrialApproval setting must be False.
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Specify a backup folder to be used during the automated deployment process.

pfadmin config trial pfst /DeployBackupFolder /u0l1/app/dbbackup

The Oracle InForm application uses this folder to store a backup of the database during
the deployment process. If the deployment fails for any reason, the application uses the
data in this folder to roll back to the state it was in prior to the deployment. The deployment
backup folder:

» Refers to a folder on the database server.
e The folder must exist on the database server, otherwise the deployment will fail.

Specify the port numbers your study will use to communicate with the following web
services:

e DeploymentService—The port number to communicate with the Oracle Central
Designer application for automated deployments.

e AuthService—The port number to communicate Reporting and Analysis module to
authorize Oracle InForm and reporting users.

e ODMSubmitService—The port number to communicate with requests to the Clinical
Data API.

pfadmin config webservice pfst DeploymentService ADD HTTP:14040
pfadmin config webservice pfst AuthService ADD HTTP:14041
pfadmin config webservice pfst ODMSubmitService ADD HTTP:14042

Start the Oracle InForm server and study using the following commands, in the order
listed:

pfadmin start server demo
pfadmin start trial pfst

Activate the system user for your study:

pfadmin setserver systempw pfst

When prompted, enter a password for the system user.

You can now log in to your study, deploy a study, and start loading data. For more information,
see Deploy your study, and the Study and Reporting Setup Guide.

Step 4. Install the Oracle Central Designer certificate

You must install a certificate on the Oracle InForm application server to verify that every
deployment package you receive from the Oracle Central Designer server comes from a
trusted source.

ORACLE

1.

Copy the public key file for the certificate that is installed on the Oracle Central Designer
server to a folder on the Oracle InForm application server.

Select Start > Run

The Run dialog box appears.
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Enter the following command, and click OK:

mmc

The Microsoft Management Console appears.

Select File > Add/Remove Snap-in.

The Add or Remove Snap-in window appears.

Select Certificates and click Add.

Click OK.

In the folder pane, expand Certificates, and select Root Certificates.
Select Actions > All Tasks > Import.

The Certificate Import Wizard appears.

When prompted:

e Browse to the location of the public key file.

«  Specify the Certificate Store for the certificate.
You can accept the default (Trusted Root Certificate Authorities), or select a different
store for the certificate.

10. Click Finish.

# Note:

When you perform this procedure to replace an expired certificate, do not remove
the public key of the old certificate if you want to deploy packages that were
previously deployed using the expired certificate.

Step 5: Update the DomainSulffix entry for the AuthenticationFilter registry
key on the Oracle InForm Application Server—Optional

ORACLE

If you are installing Cognos Reporting, you must update the DomainSuffix entry for the Oracle
AuthenticationFilter registry key if any of the following is true on the Oracle InForm Application
Server:

You use proxy servers for the Cognos Gateway Server and the Oracle InForm Application
Server.

The fully qualified domain name (FQDN) for either server does not end with a common
domain suffix.

The FQDN is registered in the Oracle AuthenticationFilter DomainSuffix entry during
installation of the Oracle InForm Application Server and the Cognos Gateway Server. If the
FQDN for both installations ends in a common domain suffix such

as .net, .com, .org, .edu, or .gov (with or without a country name like .uk or .au), you do
not need to update the DomainSuffix entry unless you use proxy servers.

The FQDN has just two levels (for example: <servername>.com).
In the Windows Registry Editor, navigate to the following Windows Registry key:
HKEY_LOCAL_MACHINE\SOFTWARE\ORACLEHS\AuthenticationFilter

Update the entry for DomainSuffix:
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a. Right-click the entry, and select Modify.
The Edit String dialog box appears.
b. Enter the new value in the Value Data field.

* If you use proxy servers, or if the FQDN for either server does not end with a
common domain suffix, remove every part of the domain suffix that is not identical
on both computers. For example, if the FQDN includes
<servername>.<companyname>.co.uk, after the edit, the entry would be
<companyname>.co.uk.

« If the Oracle InForm software and Cognos Analytics are installed on the same
machine, and the FQDN has only two nodes such as<servername>.com, you must
include the server name and the domain suffix in the entry. In the above example,
the entry would read <servername>.co.uk.

c. Click OK.
3. Exit the Windows Registry Editor.
4. Restart lIS.

5. Onthe Oracle InForm Application Server, restart the Oracle InForm Service.

Step 6: Enable SSL on the Oracle InForm Application Server—Optional

Enabling SSL is optional. For more information, see About enabling Secure Sockets Layer
(SSL).

Step 7: Create a sending address for automated study deployment
confirmation messages

The Oracle InForm application requires a valid email sender address in order to send
automated study deployment messages. This email address is stored in the
PFMngrExecutionPlan registry key on the Oracle InForm application server.

Use the following command to create the PFMngrExecutionPlan registry key and populate the
EmailSender subkey:

pfadmin config service /emailsender <validemailaddress>

Where:

* validemailaddress—The address from which emails are sent during auto-deployment.

For example:

pfadmin config service /emailsender no-reply@myexamplehost.com

® (Required) <Enter the first step.>

Step 8: Enable network access rights for automated study deployments

To enable the network access rights for automated deployments, modify the Local Security
Policy on the Oracle InForm application server:

1. Click Start > Administrative Tools > Local Security Policy.

ORACLE -
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The Local Security Policy window appears.
Select Local Policies > Security Options.

In the Policy pane, right-click Network Access: Do not allow storage of passwords and
credentials for network authentication, and select Properties.

The Network Access: Do not allow storage of passwords and credentials for network
authentication Properties window appears.

Select Disabled.
Click OK.

Set up Oracle InForm Adapter

The Oracle InForm Adapter feature provides interfaces to web services that support the secure
transfer of data between InForm studies and either Oracle products (such as the Oracle
Central Coding application) or third-party products and custom applications.

For more information, see the Configuration Guide for Oracle InForm Adapter.

Set up the Oracle InForm Adapter environment
Configuring username/password security
Configuring X.509 digital certificates

Post-installation tasks for Oracle InForm Adapter

Set up the Oracle InForm Adapter environment

Create the Oracle InForm Adapter user

Configure the Oracle InForm Adapter services

Create the Oracle InForm Adapter user

ORACLE

Before Oracle InForm Adapter can be properly configured, you need to create an Oracle
InForm Adapter user:

1.

Create an .xml file with the following structure:

<?xml-model href="schemal.xsd" ?>
<IAConfigContract>

<DATABASE>

<INSTALL>

<InformAdapterUser>
<UserName>InFormAdapterUID</UserName>
</InformAdapterUser>

<SystemUser>
<UserName>System</UserName>
</SystemUser>
<TableSpace>InForm</TableSpace>
</INSTALL>
<TnsEntry>triall</TnsEntry>
</DATABASE>

</IAConfigContract>

Specify the following values within the .xml file:
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e UserName (under <InFormAdapterUser>)—Name of the Oracle InForm Adapter
user. "InFormAdapterUID" used as an example in the previous step.

* UserName (under <SystemUser>)—Name of the Oracle InForm Adapter user with
privileges to create an Oracle InForm Adapter user. "System" used as an example in

the previous step.

* TableSpace—Table space that the Oracle InForm Adapter user is creating. "InForm"

used as an example in the previous step.

e TnsEntry—Connection information for the system and the Oracle InForm Adapter

user. "triall" used as an example in the previous step.

Navigate to the \Inform Adaptern\installScript\lIAConfiguration\bin> directory and run the
PhaseForward.InFormAdapter.lAConfigurationConsole.exe <filename> file.

# Note:

<filename> is the name of the file created in step 1.

Enter the Oracle InForm Adapter user password when prompted.

Enter the Oracle InForm Adapter system password when prompted.

Configure the Oracle InForm Adapter services

ORACLE

After creating an Oracle InForm Adapter user, you must configure the For Oracle InForm

Adapter services:

1.

Create an .xml file with the following structure:

<IAConfigContract>
<ADAPTERAPPLICATION>

<TargetAdapterApplication>installationsettings</TargetAdapterApplication>

<Action>Install</Action>

<Database>
<Name>InFormAdapterConfiguration</Name>
<Name>Storage</Name>

<Name>Auditing</Name>
<Name>JobScheduler</Name>
<Name>Locking</Name>
<Name>SystemSettings</Name>
<Name>UserSettings</Name>

</Database>

<InformAdapterUser>
<UserName>InFormAdapterUID</UserName>
</InformAdapterUser>
<Tnsname>trialpdbl</Tnsname>
<Customeruri>www.testing.org</Customeruri>
<WebElement>

<WebsiteName>INFORMADAPTER SITE</WebsiteName>
<HttpPort>14103</HttpPort>
<HttpsPort>14104</HttpsPort>
<AppPool>IAAppPo0l</AppPool>
<RootVirtualdirectory>informadapter</RootVirtualdirectory>
</WebElement>

<Application>
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<Name>ADAPTERADMINSERVICE</Name>
<Name>CENTRALADMINISTRATION</Name>
<Name>CODINGSERVICE</Name>
<Name>DISCREPANCYSERVICE</Name>
<Name>ODMSERVICE</Name>
<Name>SERVERADAPTER< /Name>
<Name>TRANSACTIONADAPTER</Name>
</Application>
</ADAPTERAPPLICATION>
</IAConfigContract>

# Note:

Do not change any of the default values under the <Database> section.

# Note:

Include the <WebElement> section only if you want to create a new website.

Specify the following values within the .xml file:

UserName (under <InFormAdapterUser>)—Name of the Oracle InForm Adapter
user. Should be the same name used during the creation of the Oracle InForm Adapter
user, in the previous section. "InFormAdapterUID" used as an example in the previous
step.

Tnsname—Connection for the Oracle InForm Adapter user. "trialpdb1" used as an
example in the previous step.

Customeruri—URI that is configured in settings. "www.testing.org" used as an
example in the previous step.

WebsiteName (under <WebElement>)—Name for the website for Oracle InForm
Adatper. "INFORMADAPTER_SITE" used as an example in the previous step.

RootVirtualdirectory (under <WebElement>)—Name for the root virtual directory for
InForm Adatper. "informadapter” used as an example in the previous step.

3. Navigate to the \Inform Adapter\installScript\IAConfiguration\bin> directory and run the
PhaseForward.InFormAdapter.lAConfigurationConsole.exe <filename> file.

# Note:

<filename> is the name of the file created in step 1.

4. Enter the Oracle InForm Adapter user password when prompted.

Configuring username/password security

The SOAP header contains elements for the user name and password for ODM Export
interface methods, and operations requests. The SOAP body contains an attribute for the
study name. The user name must represent an active account in the Oracle InForm software
and the password must be valid.

ORACLE
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For more information about the SOAP header and body, the ODM Export interface, and the ,
see the Interfaces Guide.

e ODM Export interface—configuring username/password security
e —configuring username/password security

e Coding interface—configuring username/password security

ODM Export interface—configuring username/password security

In addition to including the correct SOAP header and body information in the ODM method call,
you must also perform this procedure to configure username/password security for the ODM
Export interface.

For information about the SOAP header and body, see the Interfaces Guide.

* Deployment types - ODM Export
e Choosing the deployment type

Deployment types - ODM Export

The Oracle InForm Adapter ODM Export interface supports network access directly to the
server, network access through a load balancer, and local access. After you run the
installation, you run a script at the command line, in which you state the type of deployment
you want to use. For more information, see Choosing the deployment type.

Deployment name HTTP | HTTPS Authentication? URL / SOAP study
matching?

Default HTTPS Yes No

Load balanced HTTP * Yes Yes

LAN access HTTP No No

* Represents the data sent by the load balancer to the API.

e Default deployment
e Load balanced deployment

e LAN access deployment

Default deployment

Default deployment is configured automatically by the product installer and allows clients to
securely access the server through the top-level virtual directory. An SSL certificate must be
installed for the Oracle InForm Adapter virtual directory and the request must include a valid
user name/password used to authenticate the requests.

Example client URL:

https://myserver/InFormAdapter/ODMWCF/ODMService.svc
Load balanced deployment

Load balanced deployment is configured through modifications to the web.config file and is
intended for use when exposing the API through the use of a network load balancer. Requests
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must include a valid user name/password. For more information, see Choosing the deployment
type.

Example client URL:

https://myserver/InFormAdapter/ODMWCF/ODMService.svc

LAN access deployment

LAN access deployment allows clients on the same network-secured LAN to access the API
without security.

Example client URL:

http://myserver/InFormAdapter/ODMWCF/ODMService.svc

Choosing the deployment type

The Oracle InForm Adapter ODM Export interface comes with:

Three variations of the web.config file to support the different configurations that are used
to deploy provisioning.

The utility WebConfigFileSelector.cmd, which you use to set the appropriate config file for
your configuration type.

To select the deployment type:

1.

ORACLE

Open a Command Prompt window and change to the
<InForm_Adapter_installation_directory>\ODMWCF\ directory.

Issue the following command:

WebConfigFileSelector.cmd CONFIGURATION

where CONFIGURATION specifies the deployment type.

For example:

WebConfigFileSelector.cmd F5

The utility replaces the InFormAdaptenODMWCF\web.config file with one of the following
files.
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Deployment type Deployment type Config file Details
configuration option
Default SECURE Web_secure.config *  Secure

Load balanced

LAN access

F5

UNSECURE

Web_secure_F5.config

Web_nosecurity.config

configuration for
client requests sent
over the Internet.
Supports HTTPS
transport using
SOAP 1.2.
Requires a
Username Token in
the SOAP Security
header for providing
the user name and
password
credentials to
authenticate a
request.

Secure
configuration for
client requests sent
over the Internet
using a network
load balancer.
Supports HTTPS
into the network
load balancer and
HTTP out of it using
SOAP 1.2.
Requires a
Username Token in
the SOAP Security
header for providing
the user name and
password
credentials to
authenticate a
request.

Unsecure
configuration for
client requests sent
over a LAN from
behind a firewall.
Supports HTTP
transport and SOAP
1.2.

Does not perform
request
authentication.

—configuring username/password security

ORACLE

Deployment types

For information about the SOAP header and body, see the Interfaces Guide.

In addition to correct configuration of the SOAP header and body in the requests of operations,
you must select the type of deployment to use.
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e Choosing the deployment type

Deployment types

The Oracle InForm Adapter supports network access directly to the server, network access
through a load balancer, and local access. After you run the installation, you run a script at the
command line, in which you state the type of deployment you want to use. For more
information, see Choosing the deployment type.

Deployment nhame HTTP | HTTPS Authentication? URL / SOAP study
matching?

Default HTTPS Yes No

Load balanced HTTP * Yes Yes

LAN access HTTP No No

* Represents the data sent by the load balancer to the API.
e Default deployment
e Load balanced deployment

e LAN access deployment

Default deployment

Default deployment is configured automatically by the product installer and allows clients to
securely access the server through the top-level virtual directory. An SSL certificate must be
installed for the discrepancy virtual directory and the request must include a valid user name/
password used to authenticate the requests.

Example client URL:

https://myserver/InFormAdapter/DiscrepancyService/DiscrepancyService.svc

Load balanced deployment

Load balanced deployment is configured through modifications to the web.config file and is
intended for use when exposing the API through the use of a network load balancer. Requests
must include a valid user name/password. For more information, see Choosing the deployment

type.
Example client URL:

https://myserver/InFormAdapter/DiscrepancyService/DiscrepancyService.svc

LAN access deployment

ORACLE

LAN access deployment allows clients on the same network-secured LAN to access the API
without security. For Oracle-hosted studies, the study name is included in the URL, making
each study URL unique.

Example client URL:

http://myserver/InFormAdapter/DiscrepancyService/DiscrepancyService.svc
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Choosing the deployment type
Oracle InForm Adapter comes with:

e Three variations of the web.config file to support the different configurations that are used
to deploy provisioning.

e The utility WebConfigFileSelector.cmd, which you use to set the appropriate config file for
your configuration type.

To select the deployment type:

1. Open a Command Prompt window and change to the
<InForm_Adapter_installation_directory>\ODMWCF\ directory.

2. Issue the following command:

WebConfigFileSelector.cmd CONFIGURATION

where CONFIGURATION specifies the deployment type.

For example:

WebConfigFileSelector.cmd F5

The utility replaces the InFormAdapter\DiscrepancyService\web.config file with one of the
following files.

Deployment type Deployment type Config file Details
configuration option

Default SECURE Web_secure.config °  Secure
configuration for
client requests sent
over the Internet.

e Supports HTTPS
transport using
SOAP 1.2.

 Requires a
Username Token in
the SOAP Security
header for providing
the user name and
password
credentials to
authenticate a
request.
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Deployment type Deployment type Config file Details
configuration option

Load balanced F5 Web_secure_F5.config +  Secure
configuration for
client requests sent
over the Internet
using a network
load balancer.

e Supports HTTPS
into the network
load balancer and
HTTP out of it using
SOAP 1.2.

* Requires a
Username Token in
the SOAP Security
header for providing
the user name and
password
credentials to
authenticate a
request.

LAN access UNSECURE Web_nosecurity.config +  Unsecure
configuration for
client requests sent
over a LAN from
behind a firewall.

e Supports HTTP
transport and SOAP
1.2.

- Does not perform
request
authentication.

Coding interface—configuring username/password security

In addition to including the correct SOAP header and body information in the requests, you
must also perform this procedure to configure username/password security for the Coding
interface.

For information about the SOAP header and body, see the Interfaces Guide.

*  Deployment types
e Choosing the deployment type

Deployment types

The Oracle InForm Adapter Coding interface supports network access directly to the server,
network access through a load balancer, and local access. After you run the installation, you
run a script at the command line, in which you state the type of deployment you want to use.
For more information, se Choosing the deployment type.

Deployment name HTTP | HTTPS Authentication? URL / SOAP study
matching?
Default HTTPS Yes No
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Deployment nhame HTTP | HTTPS Authentication? URL / SOAP study
matching?

Load balanced HTTP * Yes Yes

LAN access HTTP No No

* Represents the data sent by the load balancer to the API.
*  Default deployment
e Load balanced deployment

e LAN access deployment

Default deployment

Default deployment is configured automatically by the product installer and allows clients to
securely access the server through the top-level virtual directory. An SSL certificate must be
installed for the Oracle InForm Adapter virtual directory and the request must include a valid
user name/password used to authenticate the requests.

Example client URL:

https://myserver/InFormAdapter/CodingService/CodingService.svc

Load balanced deployment

Load balanced deployment is configured through modifications to the web.config file and is
intended for use when exposing the API through the use of a network load balancer. Requests
must include a valid user name/password. For more information, seeChoosing the deployment

type.
Example client URL:

https://myserver/InFormAdapter/CodingService/CodingService.svc

LAN access deployment

LAN access deployment allows clients on the same network-secured LAN to access the API
without security. For Oracle-hosted studies, the study name is included in the URL, making
each study URL unique.

Example client URL:

http://myserver/InFormAdapter/DiscrepancyService/DiscrepancyService.svc

Choosing the deployment type

ORACLE

The Oracle InForm Adapter coding interface comes with:

e Three variations of the web.config file to support the different configurations that are used
to deploy provisioning.

e The utility WebConfigFileSelector.cmd, which you use to set the appropriate config file for
your configuration type.

To select the deployment type:
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1. Open a Command Prompt window and change to the

<InForm_Adapter_installation_directory>\ODMWCF\ directory.

2. Issue the following command:

WebConfigFileSelector.cmd CONFIGURATION

where CONFIGURATION specifies the deployment type.

For example:

WebConfigFileSelector.cmd F5

The utility replaces the InFormAdapter\CodingService\web.config file with one of the
following files.

Deployment type Deployment type Config file Details
configuration option
Default SECURE Web_secure.config e Secure

configuration for
client requests sent
over the Internet.

e Supports HTTPS
transport using
SOAP 1.2.

* Requires a
Username Token in
the SOAP Security
header for providing
the user name and
password
credentials to
authenticate a
request.

Load balanced F5 Web_secure_F5.config ¢  Secure
configuration for
client requests sent
over the Internet
using a network
load balancer.

e Supports HTTPS
into the network
load balancer and
HTTP out of it using
SOAP 1.2.

* Requires a
Username Token in
the SOAP Security
header for providing
the user name and
password
credentials to
authenticate a
request.
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Deployment type Deployment type Config file Details
configuration option
LAN access UNSECURE Web_nosecurity.config +  Unsecure

configuration for
client requests sent
over a LAN from
behind a firewall.
Supports HTTP
transport and SOAP
1.2.

Does not perform
request
authentication.

Configuring X.509 digital certificates

By default, certificates for interfaces that use certificate authentication are installed in the Local
Computer location in the Personal store on the server.

The Coding, ODM Export, and Discrepancy interfaces support multiple types of authentication.
For each interface that you are configuring for certificate authentication:

1.

2.

Issue the following command:

WebConfigSelector.cmd F5CERT

Open a Command Prompt window and change to:

<installation directory>\<interface name>

Edit CertificationStoreName in the web.config file — Optional

Edit CertificationStoreName in the web.config file — Optional

If the certificate is not installed under the Personal store, you must edit the

CertificationStoreName value in the web.config file to point to the certificate location:

1.

a 0 W Db

Navigate to:

Open the web.config file in a text editor.

Save web.config and exit the editor.
Issue the following command:
WebConfigSelector.cmd F5CERT

<installation directory>\<interface name>\web.config

Set the CertificationStoreName value to the certificate location.

Post-installation tasks for Oracle InForm Adapter

Perform the following tasks as needed for your environment:

ORACLE

Configuring the Oracle InForm Server Adapter
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e Configuring the Oracle InForm Adapter interfaces
e Increasing the timeout period for ASP.NET

*  Enabling XA transactions

* Enabling TLS

* Reqgister Trial Tool

Configuring the Oracle InForm Server Adapter

In this section:

e  Start the Server Adapter service
e Transaction detection settings for the Oracle InForm Server Adapter Service

e Including or excluding studies from processing

Start the Server Adapter service

By default, the Server Adapter service is set to manual. To use the ODM Export interface, the
Server Adapter service must be running. Start the service manually after you install the Oracle
InForm Adapter software.

For more information, see Oracle InForm Server Adapter services.

Transaction detection settings for the Oracle InForm Server Adapter Service

You can set the amount of time (in seconds) that the InFormServerAdapterService will allow
between transaction detection processing by editing the InFormServerAdapterService.config
file.

To specify a transaction detection interval:
® Edit the Updatelnterval entry:

<UpdatelInterval>300</UpdateInterval>

The default setting is 300, indicating that the InFormServerAdapterService will wait for five
minutes between transaction detection processing.

Including or excluding studies from processing

ORACLE

You can configure the Oracle InForm Server Adapter (ISA) so that only specific studies on the
Oracle InForm server are processed. This behavior might improve performance if the Oracle
InForm server contains large studies or multiple studies.

You can specify:

e The maximum number of studies to be processed at one time, by specifying the number of
threads that can be running at one time.

« Alist of studies to include or exclude from processing, based on the study prefix, suffix, or
full name.

To configure the Oracle InForm Server Adapter service:

1. On the Oracle InForm server, use the Windows Administrative Tools to stop the Oracle
InForm Server Adapter service.
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2. In atext editor, open the InFormServerAdapterService.config file.

3. Use TrialThreadPool to specify the number of threads to process the studies on the Oracle

InForm server. For more information, see the TrialThreadPool comments in the config file.

4. To include or exclude studies from processing, uncomment the appropriate

InclusionCondition or ExclusionCondition line and specify a value. For more information,
see the InclusionList comments in the InNFormServerAdapterService.config file.

Configuring the Oracle InForm Adapter interfaces

Each Oracle InForm Adapter web service has two configuration files:

e The application configuration file

e The web.config file

The application configuration file

ORACLE

Each web service and Oracle InForm Adapter Windows service has an application
configuration file. This file contains product-specific Oracle application configuration settings.

The application configuration files are in the \bin\config directories for the interfaces. They are
named as follows:

Service type File name /| Example

Web service InFormAdapter.<interfacename>.config
Example: InFormAdapter.coding.config
Location: <installation_directory>\coding\bin\config

Windows service <servicename>Service.config
InFormServerAdapterService.config

In the application configuration files, you can configure any of the following settings:

Error logging settings

The Oracle InForm Adapter software uses the open source log4net component (http://
logging.apache.org/log4net/) to perform error logging to a configurable location.

e By default, all Oracle InForm Adapter web services and Windows services are configured
to log all errors that occur to the event viewer.
However, they can be configured to log additional information to a log file or some other
location.

*  Some requests that return errors deliver the errors to the calling application or client
process.
In some situations (for example, when the debugging level of error logging is enabled),
only the errors related to the request are relayed to the calling application. Debugging
errors can be routed to another location.

For more information, see http://logging.apache.org/log4net/release/config-examples.html.
Setting the ChunkSize parameter in the InFormAdapter.Coding.config file

The ChunkSize parameter is the number of transactions that the Oracle InForm Adapter
software looks at in a single coding get request call, and determines whether the
PFEX_VERBATIMCACHE table needs to be updated based on new data, deleted data, or
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changed data in the Oracle InForm software. The ChunkSize parameter is set to 2000 by
default.

In very large studies in which the PFEX_VERBATIMCACHE table is rebuilt (for example, when
a new mapping is implemented) you might need to increase the value of the ChunkSize
parameter. Increasing the value can improve performance of the PFEX_VERBATIMCACHE
table rebuild if the verbatim density across the transactions in the study is not too high.

For example, in a very large study, transactions that contain verbatim information could be
spread out over several thousand transactions. If the ChunkSize is set to 2000, each call made
to the Adapter might update/insert only a few records. If the ChunkSize is set to 20000, each
call will bring back many more verbatims. The disadvantage to this higher setting would occur
in studies that have a high density of verbatims (such as if all 20000 transactions are from
verbatim data). The call to the adapter could take a long time and potentially time out.

The value of the ChunkSize parameter is global to the Oracle InForm Adapter server and will
affect all studies registered on that server.

To set the ChunkSize parameter edit the InFormAdapter.Coding.config file entry (this shows
the default):

<ChunkSize size="2000" />

For example, in a very large study (greater than one million transactions) change the size to
20000:

<ChunkSize size="20000" />

Enabling or disabling ODM data reduction

ODM data reduction reduces redundancies in ODM output. Items are identified as unique
based on their identifying key (OID, repeat key, etc). Contents of items that have the same key
are reduced to a single item, in chronological order. The output remains ODM compliant, but is
more compact.

ODM data reduction is enabled by default.

You can disable ODM data reduction for the output of the GetTransactions method by including
the parameter skipODMReduction=TRUE in input request to the method.

You can disable reduction for all studies on the server by uncommenting the element
<SkipODMReduction /> in the INnFormAdapter.ODM.config file. The request parameter value,
if specified in the method call, takes precedence over the server-wide element value in the
configuration file.

For example, if you uncomment <SkipODMReduction /> in the configuration file, and include
skipODMReduction=False in the call to the GetTransactions method for study pfst450dm,
only the GetTransactions response for that particular request to trial pfst450dm will apply ODM
data reduction to the response.

For more information, see the Interfaces Guide.

The web.config file

The Oracle InForm Adapter software uses web.config files for configuring the web services for
each interface, including the Oracle InForm Server Adapter (ISA) interface on the InForm
application server.
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The web.config file is part of the Microsoft configuration architecture. For more information, see
the MSDN documentation.

The web.config file should be used to configure security for each Oracle InForm Adapter
interface.

Increasing the timeout period for ASP.NET

If a web service request runs longer than the default timeout period for ASP.NET, the following
message might appear:

Attempted to access an unloaded AppDomain

Such a timeout could occur during synchronization.

To resolve this issue, increase the value for responseDeadlockinterval in the
machine.config file on the servers. The default value is three minutes. This is a global value
that applies to all ASP.NET applications. For more information about setting the value, see the
Microsoft documentation (http://www.asp.net/).

# Note:

Oracle recommends that you do not change the responseDeadlockinterval value
unless you receive the error as described.

Enabling XA transactions

To use Oracle InForm Adapter, XA transactions must be enabled.
1. Select Start > Apps > Component Services.

2. Inthe console tree, expand Component Services > Computers > My Computer >
Distributed Transaction Coordinator.

3. Right-click Local DTC, and select Properties.
The Local DTC Properties dialog box appears.
4. Click the Security tab.
5. Inthe Security Settings section, select Enable XA Transactions.
6. Click OK.

Enabling TLS

If you use certificate authentication, Oracle recommends that you enable TLS 1.2 and disable
TLS 1.1 and older on the Oracle InForm Adapter computer.

Make sure the following registry keys and subkeys exist in
HKLM\SY STEM\CurrentControlSet\Control\SecurityProviders\SCHANNEL\Protocols:
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Key Subkeys and entries
SSL 2.0 Client:
» DisabledByDefault=1
Enabled=0
Server:
» DisabledByDefault=1
Enabled=0
SSL 3.0 Client:
*  DisabledByDefault=1
*  Enabled=0
Server:
*  DisabledByDefault=1
*  Enabled=0
TLS 1.0 Client:
e DisabledByDefault=1
*  Enabled=0
Server:
e DisabledByDefault=1
*  Enabled=0
TLS 1.1 Client:
e DisabledByDefault=1
*  Enabled=0
Server:
e DisabledByDefault=1
*  Enabled=0
TLS 1.2 Client:
e DisabledByDefault=0
*  Enabled=1
Server:
e DisabledByDefault=0
*  Enabled=1

Register Trial Tool

The Register Trial Tool is a command line tool that you use to register a study, decommission a
study in Oracle InForm Adapter, and view lists of existing studies and decommissioned studies.

Decommissioned studies in the InForm software and Oracle InForm Adapter
Using the Register Trial Tool

Register a study

Decommission a study

View a list of studies

Decommissioned studies in the InForm software and Oracle InForm Adapter

ORACLE

A study that has been decommissioned in the Oracle InForm software is removed from the
Oracle InForm database, but connection information remains in the Oracle InForm Adapter
database. If you install or upgrade the Oracle InForm software, the Oracle InForm Adapter
installation program attempts to upgrade the study database, but fails because it cannot locate
information about the decommissioned study in the Oracle InForm database.
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To prevent this situation, use the Register Trial Tool to decommission the study in the Oracle
InForm Adapter database.

Using the Register Trial Tool

The Register Trial Tool is always installed with Oracle InForm. When installation is complete,
the tool can be found in:

<installation_directory>\RegisterTrialTool\bin

< Note:

You must be an administrator (part of the administrator group for Oracle InForm
Adapter) to run the Register Trial Tool. You cannot run the Register Trial Tool with
User Access Control turned on. You must either log in as an administrator or open a
command window as an administrator.

To use the Register Trial Tool:

1. Open a Command Prompt window and change to the RegisterTrialTool\bin directory.
2. Issue the command RegisterTrialTool.

The command displays the usage of each option. With the Register Trial Tool you can do the
following tasks:

e Register a study.
e Decommission a study.
* View a list of studies.

For each task, you are prompted to enter the password for the Oracle InForm Adapter
database and, if required, the study database.

Register a study

ORACLE

SetTrial

Registers a study in the Oracle InForm Adapter database.

# Note:

SetTrial also registers InForm Adapter in the Integration Manager.

If the study name and study alias exist, SetTrial updates the other information you specify.
Syntax

RegisterTrialTool SetTrial <informadapter-user> <adapterDBConnectionStr>
<trial-alias> <trial-name> </virtualdirectory:virtual-directory-name>

Considerations

<trial-name>
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If you are using Oracle Data Management Workbench (Oracle DMW) for the study, take note of
the study name you enter here. You must enter the exact same study name when you set up
the study in Oracle DMW.

Example

RegisterTrialTool.exe SetTrial informadapteruser devl testtrial testtrial /
virtualdirectory:http://<hostname>:<port>/InFormAdapter

Decommission a study

decommission

Removes the study from the Oracle InForm Adapter database. The command also marks the
study as decommissioned in the PFIA_TRIALINFORMATION table in the InForm Adapter
database.

Syntax

RegisterTrialTool decommission <informadapter-user> <adapterDBConnectionStr>
<trial-alias> <trial-name>

Example

RegisterTrialTool.exe Decommission informadapteruser devl testtrial testtrial

View a list of studies

list
Generates the following lists:

»  Studies that are currently registered in the Oracle InForm Adapter database.
« Oracle InForm Server Adapters that are registered in the Oracle InForm Adapter database.

e Studies that have been decommissioned in the Oracle InForm Adapter database.
Syntax

RegisterTrialTool list <informadapter-user> <adapterDBConnectionStr>

Example

RegisterTrialTool.exe List informadapteruser devl

Set up Oracle InForm Publisher

The Oracle InForm Publisher feature publishes data from Oracle InForm studies that can be
imported to a target application. To use the Oracle InForm Publisher feature with an Oracle
InForm study, you must configure the feature to work with the study and the target application.

For more information, see the Configuration Guide for InForm Publisher.
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* Installing a certificate for the Oracle InForm Publisher software

* Installing the Oracle InForm Publisher software with the installer wizard

Installing a certificate for the Oracle InForm Publisher software

If the endpoint that the Oracle InForm Publisher application calls to update data to the
subscriber destination requires a client certificate, you must set up a client certificate for the
Oracle InForm Publisher Service to call the endpoint.

This is performed through the Certificates MMC snap-in in Microsoft Windows. Because the
Oracle InForm Publisher Service runs as the local service user, you must add the certificate to
the certificate store for the local computer for the Oracle InForm Publisher Service.

Installing the Oracle InForm Publisher software with the installer wizard

To finialize the set up of Oracle InForm Publisher, run the following commands:

1. Using the admin command prompt, create publisher service: InstallConfiguration.exe/
install

2. Create the Queue Grantor User in the DB: PublisherAdmin.exe grantor set and follow
the instructions on screen.

¢ Note:

This step is only necessary if you intend to use the Safety Subscriber for the Oracle
InForm-to-Oracle Argus Safety Integration.

Install the sample study

The sample study is created in the Oracle Central Designer application and made available to
the Oracle InForm server, along with a public key certificate that you must install on your
Oracle InForm application server.

Before you can install the sample study, you must:

e Create a skeletal study to deploy the samples study.
For more information, see Step 3: Set up a skeletal study.

» Install the Oracle Central Designer certificate.
For more information, see Step 4: Install the Oracle Central Designer certificate

e About the sample study
e Deploying the sample study

About the sample study

The sample study contains examples of the types of components you can use when you
design your own study. Before deploying your own study, you might want to run the sample
study to familiarize yourself with the Oracle InForm application.
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Deploying the sample study

ORACLE

# Note:

Oracle recommends running the sample study only on a development server. Do not
run a sample study on a production server.

To deploy the sample study:

1.

Copy the deployment package created on this release of Oracle Central Designer server to
the Oracle InForm application server. For more information see the Oracle Central
Designer Installation Guide.

Log in to the Oracle InForm study as a sponsor user with the Study Deployment right.

# Note:
For more information about creating a sponsor user, see User Guide for
Administrators
In the navigation toolbar, click Deployment.
The Deployment page appears.
Select a deployment package.
a. Click Browse | Choose File.
The Choose File to Upload / Open dialog box appears.
b. Select the deployment package and click Open.

The name of the deployment package you selected appears in the Deployment
Package field.

Click in the Scheduled Time field to schedule a time and date to deploy the study
package.

A calendar control appears.
Do one of the following:
e To run the deployment package immediately, click Immediate, and then click Done.

e To run the deployment package at a later date and time, select the appropriate date
and time options, and then click Done.

The Upload button becomes active.
Click Upload.

The deployment package file name appears on the Deployment page with a status of
Scheduled.

Once the study has been deployed successfully, please refer to the steps to create users
and sites for the study. For more information see the User Guide for Administrators.
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Qualify the installation

Qualifying the installation verifies that the study was installed successfully. The qualification
process consists of a set of administrative and clinical activities that perform the basic
functionality of the Oracle InForm application. The tests are divided into Admin and CRC/CRA
tests.

e Qualification prerequisites

¢ Admin—Users test

e Admin—Rights test

e Admin—Sites test

e Admin—Groups test

e Admin—Users and Groups test
* CRC/CRAtests

Quialification prerequisites

e Oracle InForm software is installed. For more information, see Step 2: Install the Oracle
InForm core software on the InForm Application Server.

e Sample study is installed, and the server and study are running. For more information, see
Install the sample study.

e The pfadmin setserver command has activated and assigned a password to the system
user. For more information, see pfadmin and look for the systempw option for the
setserver command.

Admin—Users test

ORACLE

1. Log in as the system user.
2. Click Admin.

3. Select each of the following: Users, Rights, Groups, Sites, Configuration, Events,
Rules, and System.

4. On the Users page, click Add User.

5. Enter a user name in the User Name field.
a. Inthe User must change password at next login field, select No.
b. Select values in the Product Locale and Preferred Study Locale fields.
c. Click Submit, and click OK in the message box.

6. Click Return and verify that the added user is shown in the list.

7. Click the Account Name and the Group tab for the added user.
a. Assign a rights group and two user site associations.
b. Click Submit, and click OK in the message box.

8. Click Return and click any link for the new user.

9. Click Change Password.

a. Give user X a password with eight characters or more.
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b. Click Submit, and click OK in the message box.

Click Return and select User Active.

a. Click Submit, and click OK in the message box.

b. Log out.

Log in as the new user, using the password assigned in Step 9.

Click Subjects verify that the Site drop-down list contains only the sites selected in Step 7.

Log out.

Admin—Rights test

1
2
3.
4

Log in as the system user.
Select Rights. Click Add Rights Group.
Enter new rights group information. Click Submit, and click OK in the message box.

Click Return. Verify that the rights group that you just created is in the list.

Admin—Sites test

1.
2.
3.

Select Sites
Click Add Site.

Enter the new site information. Site Name, Site Mnemonic, and Study Locale are
required.

Click Submit, and click OK in the message box.

Click Return and verify that the site that you just created is in the list.

Admin—Groups test

© © N o g » 0w NP

Select Groups.

Click Add Group.

Select Signature from the Group Type drop-down list, and type the group information.
Click Submit, and click OK in the message box.

Click Return and verify that the signature group you just created is in the list.

Click Add Group.

Select Query from the Group Type drop-down list, and enter group information.

Click Submit, and click OK in the message box.

Click Return and verify that the query group you just created is in the list.

Admin—Users and Groups test

ORACLE

1.

Select Groups. In the Members column for the signature group that was created in the
Admin—Groups test section, click Change.

For more information, see Admin—Groups test.

Select the user in the Available users list and click Add.
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Verify that the user is in the Users in (signature group) list and click Submit, and then click
OK in the message box.

Click Return and verify that the Member Count column shows 1 (and not 0) for the
signature group.

In the Members column for the query group that was created in the Admin—Groups test
section, click Change.

For more information, see Admin—Groups test.
Select the user in the Available users list and click .

Verify that user X is in the Users in (query group) list and click Submit, and click OK in the
message box.

Click Return and verify that the Member Count column shows 1 (not 0) for the query
group.
Log out.

CRC / CRA tests

As a CRC user

1.

ORACLE

1.
2.

Open two browser windows, log into the study that was deployed.
Create CRC and CRA rights groups with rights applicable to those roles.
For more information, see Typical rights for CRA and CRC rights groups.
Assign users to these rights groups.

Log in to one session as a CRC user and the other as a CRA user.
Perform the CRC/CRA tests.

As a CRC user
As a CRC user and a CRA user

Click Enroll and click Add Candidate.

A question window appears.

Enter subject information and click Submit.

Click the Screening Number for the subject who was just entered.

Edit one of the fields, provide a reason for change, and click Submit. Verify that the field
you edited is changed.

Click Return.
In the Enrolled column, and click the Enroll link.

Enter the subject number (site ID followed by a hyphen and a 3-digit number) and click
Submit.

The System Enroliment page displays the heading Candidate Meets All Criteria for
Enrollment in Study.

At the bottom of the page, click Enroll.

If your study is configured to display the visit calculator, verify that a Visit Calculator
(subject schedule) page appears for the subject with a default baseline date of the current
date.
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Change the Start Date and verify that the associated dates are updated correctly.
Click Go To First Visit.

Complete the DOV form and click OK.

The list of forms for the first visit appears. Navigate to each form in the first visit.

Click the Time and Events arrow at the left end of the visit ruler and view the Time and
Events Schedule to check all visits for the new subject.

Click the status icon for the Base visit and click the status icon for the Demographics form.
Enter data in the form, and click Submit.

Click Return.

Click the status icon for the Vital Signs form and enter a value of 94.50 degrees Fahrenheit
in the Temperature item.

Click Submit, and verify that an autoquery is generated.
The background for the question becomes pink and an error message is shown in red.

Click the comment icon in the right column for an item, and add a comment in the
Comment field.

Click Submit, and click OK in the message box.
Click Return and click the query text.

On the Queries detail page, click Update Data and Answer and change the Temperature
value to 98.60 and add a reason for change.

Click Submit, and click OK in the message box. Verify that the auto-query is answered.
The background for the question changes from pink to gray.

Click the status icon for any form that has data.
Select Mark SV Ready from the Select Action list, and click Apply.
Click the status icon for the Demographics form.

Select Print Preview from the Select Action list, and click Apply. Verify that the preview
of the form appears.

Click Print.
Verify that the report prints with the correct information.

Click the Help icon, and select InForm Help and verify that the Get Started page of the
Oracle InForm documentation library opens.

As a CRC user and a CRA user

ORACLE

1.

# Note:

Keep both browsers open to make the following steps easier to perform.

As a CRA user:
a. Click Subjects.

b. Inthe Subject column, click the link for the subject that was created by the CRC user
in the CRC test.

c. Click the status icon for the Base visit. The list of forms appears.
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Click the status icon for the Demographics form.

Create an open query on an item entered by the CRC user:

Click the query icon ("'-?l-ﬁ') for the item, click Create Query, select Create Query in
Opened State in the Action list, and select a reason.

Click Submit, and verify that the query appears with red text in a pink box under the
item.

2. As aCRC user:

f.

Click Subijects.

In the Subject column, click the link for the subject who was created by the CRC user
in the CRC test.

Click the status icon for the Demographics form.
To answer the query, click the query icon or the red query text.

In the Current Value section, click Answer. In the Query section, enter a response to
the query.

Click Submit, and verify that the query disappears from the form.

3. As a CRA user:

C.

d.

Refresh the Demographics form: click the CRF history icon (tEl), and select the
Demographics form.

To re-issue the answered query click the query icon, and in the Current Value section,
click Reissue as Open.

In the Query section, select a reason.

Click Submit, and verify that the query reappears.

4. As a CRC user:

a.

b.

Refresh the Demographics form: click the CRF history icon (tE'r), and select the
Demographics form.

To re-answer the query, click Submit, and verify that the query disappears from the
form.

5. As CRA user:

C.

d.

Refresh the Demographics form: click the CRF history icon (tE',), and select the
Demographics form.

To close the query, click the query icon, and in the Current Value section, click Close
Query.
In the Query section, select a reason.

Click Submit, and verify that the query disappears from the form.

6. Log out of both browser sessions.

ORACLE
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Preparing the Reporting application servers

In this section:

e About preparing the Reporting application servers
e Prepare the Oracle Directory Server

e Prepare the Cognos Content Manager Server

e Prepare the Cognos Report Server

e Prepare the Cognos Gateway Server

e Common steps for Reporting application servers

About preparing the Reporting application servers

You must perform a specific series of steps on the reporting servers to prepare them for use
with the Oracle InForm application. Some of the same steps are required on each server, and

some steps are unigue to the server type.

*  Oracle Directory Server
For more information, see Steps to prepare the Oracle Directory Server.

»  Cognos Content Manager Server
For more information, see Prepare the Cognos Content Manager Server.

e Cognos Report Server
For more information, see Prepare the Cognos Report Server.

e Cognos Gateway Server
For more information, see Prepare the Cognos Gateway Server.

For information on how to configure load balancing for the reporting servers in a distributed

environment, see the Cognos Analytics Administration and Security Guide.

Prepare the Oracle Directory Server

In this section:

e Steps to prepare the Oracle Directory Server

e Step 1: Install the Oracle Directory Server

e Step 2: Create the ORACLEHS organizational unit (OU) and crnsysadmin user on the

Oracle Directory Server

Steps to prepare the Oracle Directory Server

ORACLE

The Oracle Directory Server is required only if you are using Reporting.
To prepare the Oracle Directory Server:

1. Install the Oracle Directory Server.

6-1



Chapter 6
Prepare the Oracle Directory Server

For more information, see Step 1: Install the Oracle Directory Server.
2. Create the ORACLEHS namespace and crnsysadmin user on the Oracle Directory Server.

For more information, see Step 2: Create the ORACLEHS organizational unit (OU) and
crnsysadmin user on the Oracle Directory Server.

# Note:

You also create an ORACLEHS namespace and a crnsysadmin user on the
Cognos Content Manager Server when you run the Cognos Analytics
Customization for InForm wizard. For more information, see Run the Cognos
Analytics Customization for InForm wizard—Cognos Content Manager / Cognos
Report Server.

Step 1: Install the Oracle Directory Server

1. Download and install the Oracle Directory Server.
2. Configure and deploy the Oracle Directory Server to a supported web server.

For more information, see the Oracle website, the Oracle Directory Server Enterprise
Edition documentation, or your Oracle database documentation.

Step 2: Create the ORACLEHS organizational unit (OU) and crnsysadmin
user on the Oracle Directory Server

ORACLE

If you are using Reporting, you create an ORACLEHS namespace and crnsysadmin user on
the Cognos Content Manager Server and the Cognos Report Server when you run the Cognos
Analytics Customization for InForm wizard. For more information, see Run the Cognos
Analytics Customization for InForm wizard—Cognos Content Manager / Cognos Report
Server.

1. On the server where the Oracle Directory Server is installed, use the Cognos Configuration
utility to ensure that the Cognos Analytics Service is stopped.

2. Launch the URL for the Oracle Directory Server and log in to the Oracle Directory Service
Control Center.

3. Select the Directory Server tab.

4. Inthe Directory Servers list, click the server name.
The Server Operations tab opens.

5. Select the Entry Management tab.

6. From the Browse Data list, select the DN , and click New Entry.
The New Entry wizard page displays the Specify Entry Location page.

7. Make sure that the Entry Parent DN is correct, and click wizard button next.
The Choose Object Class page appears.

8. From the Entry Type drop-down list, select Organizational Unit - (organizationalUnit),
and click wizard button next.

The Configure Attributes page appears.
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In the Organizational Unit (ou) field, type ORACLEHS (all uppercase), and click wizard
button next.

The Summary page appears.
Review the information, and if it is correct, click wizard button finish.
The ORACLEHS node is added to the Browse Data list.

On the Entry Management tab, in the Browse Data list, right-click ou=ORACLEHS ,and
click New Entry.

The New Entry wizard displays the Specify Entry Location page.
Make sure that the Entry Parent DN is correct, and click wizard button next.
The Choose Object Class page appears.

From the Entry Type drop-down list, select User - (inetOrgPerson), and click wizard
button next.

The Configure Attributes page appears.

Create a new user for the ORACLEHS namespace as follows:

*  Full Name (cnh)—crnsysadmin

e Last Name (sh)—crnsysadmin

e User ID (uid)—crnsysadmin

» Password (userPassword)—<crnsysadmin password>

e Confirm Password—<crnsysadmin password>

Click wizard button next.

The Summary page appears.

Review the information, and if it is correct, click wizard button finish.

The uid=crnsysadmin node appears in the Browse Data list on the Entry Management tab.

Prepare the Cognos Content Manager Server

All Oracle InForm installations with Reporting use a Cognos Content Manager Server.

ORACLE

To prepare the Cognos Content Manager Server:

Step 1: Verify the Oracle database client on the Cognos Content Manager Server
Step 2: Install the Cognos software on the Cognos Content Manager Server
Step 3: Set up JRE on the Cognos Content Manager Server

Step 4: Set up the Oracle JDBC driver

Step 5: Run the Cognos Analytics Customization for Oracle InForm wizard on the Cognos
Content Manager Server

Step 6: Start the Cognos service on the first Content Manager Server—For distributed
Cognos installations only

Step 7: Customize the Cognos Analytics email settings on the Cognos Content Manager
Server—For self-hosted studies only

Step 8: Enable SSL on the Cognos Content Manager Server—Optional
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Step 1. Verify the Oracle database client on the Cognos Content Manager
Server

Before you begin, ensure that you have followed the instructions in Steps to install and
configure the Oracle database client so that the following requirements are met on the Cognos
Content Manager Server:

e The Oracle database client is installed.
e The language registry settings are updated.
e The database connection is configured and verified.

This step is also performed on the Cognos Report Server.

Step 2: Install the Cognos software on the Cognos Content Manager Server

e The Oracle database client is installed.
e The language registry settings are updated.
e The database connection is configured and verified.

This step is performed on the Cognos Report Server.

For more information, see Install the Cognos software—Cognos Content Manager / Cognos
Report Server.

Step 3: Set up JRE on the Cognos Content Manager Server

To enable the Cognos software to find the necessary Java components when it runs, you must
set the JAVA_HOME environment variable on the Cognhos Content Manager Server.

This step is also performed on the Cognos Report Server.

For more information, see Add JRE to the JAVA_HOME environment variable.

Step 4: Set up the Oracle JDBC driver

Before running the Cognos Customization for Oracle InForm wizard, you must set up the
Oracle JDBC driver on the Content Manager Server.

1. Download the ojdbc7.jar file from the Oracle support website.

2. Copy the ojdbc7.jar file to the <Cognos_ Installation_Directory>\drivers folder.

Step 5: Run the Cognos Analytics Customization for Oracle InForm wizard
on the Cognos Content Manager Server

The Cognos Analytics customization wizard copies customization files and modifies files
needed to customize the Cognos Analytics software for the Oracle InForm application.

This step is performed on the Cognos Report Server.

For more information, see Run the Cognos Analytics Customization for InForm wizard—
Cognos Content Manager / Cognos Report Server.
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Step 6: Start the Cognos service on the first Content Manager Server—For
distributed Cognos installations only

If your deployment includes a distributed Cognos Analytics installation, after you install the
Cognos software on the first server, start the Cognos service on this server to designate it the
active Content Manager.

Start the Cognos service on the rest of the Content Manager Servers only after you perform
steps 1-5 on all the standby Content Manager Servers.

Step 7: Customize the Cognos Analytics email settings on the Cognos
Content Manager Server—For self-hosted studies only

Cognos Analytics includes a feature that allows you to send natifications by email with links to
reports and attach report output to the emails.

# Note:

This feature is not available for Oracle-hosted studies.

Normally, you configure email to point to the Cognos Gateway server. However, if your
environment uses an F5 switch that requires a generic URL to access the switch, you must
configure the SMTP server to use the correct address.

1. Using the Cognos Configuration utility, configure the SMTP mail server.

For more information, see the Cognos Analytics Installation and Configuration Guide.
2. Select File > Save.

The Cognos Configuration utility validates the settings and saves the configuration.

3. When the validation checks are complete (all items are marked with a green check mark),
click Close.

4. Click Close, and close the Cognos Configuration utility window.

Step 8: Enable SSL on the Cognos Content Manager Server—Optional

Enabling SSL is optional. For more information, see About enabling Secure Sockets Layer
(SSL).

Prepare the Cognos Report Server

ORACLE

All Oracle InForm installations with Reporting use a Cognos Report Server.
To prepare the Cognos Report Server:

e Step 1: Verify the Oracle database client on the Cognos Report Server
*  Step 2: Install the Cognos software on the Cognos Report Server

e Step 3: Set up JRE on the Cognos Report Server

e Step 4: Set up the Oracle JDBC driver
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e Step 5: Run the Cognos Analytics Customization for InForm wizard on the Cognos Report
Server

e Step 6: Enable SSL on the Cognos Report Server—Optional

Step 1. Verify the Oracle database client on the Cognos Report Server

Before you begin, ensure that you have followed the instructions in Steps to install and
configure the Oracle database client so that the following requirements are met on the Cognos
Report Server:

e The Oracle database client is installed.
e The language registry settings are updated.
e The database connection is configured and verified.

This step is also performed on the Cognos Content Manager Server.

Step 2: Install the Cognos software on the Cognos Report Server

You must install the Cognos core software on the Cognos Report Server.
This step is also performed on the Cognos Content Manager Server.

For more information, see Install the Cognos software—Cognos Content Manager / Cognos
Report Server.

Step 3: Set up JRE on the Cognos Report Server

To enable the Cognos software to find the necessary Java components when it runs, you must
set the JAVA_HOME environment variable on the Cognos Report Server.

This step is also performed on the Cognos Content Manager Server.

For more information, see Add JRE to the JAVA_HOME environment variable.

Step 4. Set up the Oracle JDBC driver

Before running the Cognos Customization for Oracle InForm wizard, you must set up the
Oracle JDBC driver on the Report Content Server.

1. Download the ojdbc7.jar file from the Oracle support website.

2. Copy the ojdbc7.jar file to the <Cognos_ Installation_Directory>\drivers folder.

Step 5: Run the Cognos Analytics Customization for InForm wizard on the
Cognos Report Server

The Cognos Analytics Customization for Oracle InForm wizard copies customization files and
modifies files needed to customize the Cognos Analytics software for the Oracle InForm
application.

This step is also performed on the Cognos Content Manager Server.

For more information, see Run the Cognos Analytics Customization for InForm wizard—
Cognos Content Manager / Cognos Report Server.
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Step 6: Enable SSL on the Cognos Report Server—Optional

Enabling SSL is optional. For more information, see About enabling Secure Sockets Layer
(SSL).

Prepare the Cognos Gateway Server

All Oracle InForm installations with Reporting use a Cognos Gateway Server.
To prepare the Cognos Gateway Server:

e Step 1: Run the Cognos Analytics Gateway Customization for Oracle InForm wizard on the
Cognos Gateway Server

e Step 2: Enable SSL on the Cognos Gateway Server—Optional

Step 1: Run the Cognos Analytics Gateway Customization for Oracle
InForm wizard on the Cognos Gateway Server

The Cognos Analytics Gateway Customization for Oracle InForm wizard creates the Cognos
virtual directory and sets up a reverse proxy rule to forward all Cognos requests from IIS to the
Cognos dispatchers.

1. Extract the Cognos Analytics Gateway Customization for Oracle InForm archive from the
Oracle InForm installation archive to a location that you can access from the Cognos
Gateway Server.

2. Onthe Cognos Gateway Server, run the setup.exe program file from the extracted archive.
The Choose Setup Language page appears.

3. Select the language you want the wizard to use during setup. Select either English or
Japanese. English is the default. Click Next.

The Cognos Analytics Welcome Screen appears.
4. Click Next.
The Provide IIS Parameters for configuring Cognos Gateway Server screen appears.

5. Under Cognos Virtual Directory, enter a location on the gateway server where the Cognos
Analytics virtual directory in IIS > Default Web Site will point to. A folder named Cognos
[version] is created in this location.

6. Under Reverse Proxy Rule Parameters, enter the following:

e Cognos Application Server FQDN—Fully qualified domain name of the Cognos
application server or dispatcher.

e Cognos Application Server Port—Port number used to communicate with the Cognos
application server or dispatcher. Enter 9300, unless a different port was manually
configured.

«  Cognos Application Server protocol—If SSL is enabled on the application server,
select https. Otherwise, select http.

7. Click Next.
The Ready to Install the Program page appears.
8. Click Install.
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The Setup Status page appears.

The program installs, and the World Wide Web Publishing Service restarts.
The Wizard Complete page appears.

Click Finish.

Step 2: Enable SSL on the Cognos Gateway Server—Optional

Enabling SSL is optional. For more information, see About enabling Secure Sockets Layer
(SSL).

Common steps for Reporting application servers

In this section:

Install the Cognos software—Cognos Content Manager / Cognos Report Server
Add JRE to the JAVA_HOME environment variable

Run the Cognos Analytics Customization for InForm wizard—Cognos Content Manager /
Cognos Report Server

Install the Cognos software—Cognos Content Manager / Cognos Report

Server

Run the Cognos Analytics installation to install the following components:

Cognos Analytics Content repository (Cognos Content Manager)
For more information, see Step 2: Install the Cognos software on the Cognos Content
Manager Server.

Cognos Analytics Application services (Cognos Report Server)
For more information, see Step 2: Install the Cognos software on the Cognos Report
Server.

If you are installing the Cognos components in a distributed environment, before you install the
standby Content Manager and Report Servers make sure that on the first Content Manager
Server (the active Content Manager):

The Cognos software is installed.
The Cognos Analytics Customization for InForm is installed.

The Cognos service is running.

Run the Cognos Analytics installation

Run the Cognos Analytics installation

ORACLE

For information on how to run the Cognos installation, please refer to the latest applicable
Oracle InForm Reporting Cognos Installation Guide listed under Cognos documentation on the
Oracle Help Center.

Add JRE to the JAVA_HOME environment variable

Set the JAVA_HOME environment variable to the path for the Java Runtime Environment 1.8
(for example, C:\Program Files\Java\jre1.8.0_141) on the following reporting servers:
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Cognos Content Manager Server
For more information, see Step 3: Set up JRE on the Cognos Content Manager Server.

Cognos Report Server
For more information, see Step 3: Set up JRE on the Cognos Report Server.

You must update the environment variable with the full path every time you install a JRE
update.

Run the Cognos Analytics Customization for InForm wizard—Cognos
Content Manager / Cognos Report Server

To customize the Cognos Analytics software for the Oracle InForm environment, you run
installation and configuration wizards.

ORACLE

You run the Cognos Analytics Customization for Oracle InForm wizard on the following
reporting servers:

Cognos Content Manager Server
For more information, see Step 5: Run the Cognos Analytics Customization for Oracle
InForm wizard on the Cognos Content Manager Server.

Cognos Report Server
For more information, see Step 5: Run the Cognos Analytics Customization for InForm
wizard on the Cognos Report Server.

Extract the Cognos Analytics Customization for InForm archive from the Oracle InForm
installation archive to a location that you can access from the Cognos Content Manager
Server and the Cognos Report Server.

On the Cognos Content Manager Server and the Cognos Report Server, run the setup.exe
program file from the extracted archive.

The Choose Setup Language window appears.

Select the language you want the wizard to use during setup. Select either English or
Japanese. English is the default. Click Next.

The Welcome page appears.
Click Next.
The Cognos Analytics Installation Location page appears.

Specify the folder in which the Cognos Analytics Content Manager is installed, and click
Next.

The Java Runtime Environment (JRE) Version Information page appears.
Browse to the location where the JRE is installed, and click Next.
The Cognos Content Store and Application Firewall page appears.

Enter the following values:

Field Description

Database server Fully qualified domain name of the database
server where the Cognos Analytics Content
Store schema is installed.

Port Port number for communicating with the
database server.

SID SID for communicating with the database server.
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Field

Description

User Name

User name of the Oracle user in the Cognos
Analytics content store database. You created
this user when you configured the Cognos
Analytics content store database.

Password, Confirm Password

Cognos Analytics user in the Cognos content
store database.

Valid Domain or Host

Comma-separated list of domain or host names,
for example *.company.com,*.companycorp.com.

Click Next.

The Custom Authentication Provider Configuration and Single Sign-On Information page

appears.

Enter the following values:

Field

Description

Database server

Fully qualified domain name of the user that
contains the TRIAL_URLS table.

Port Port number for communicating with the
database server.

SID SID for communicating with the database server.

User Name The name of the PFCapAdmin user.

Password, Confirm Password

Password of the PFCapAdmin user.

Integrated with Single Sign-on

Select to enable Single Sign-on.

# Note:

This selection, and the following two
options should be selected only if your
application is running in an Oracle-
hosted, single sign-on environment.

Cognos Content Manager Component is

installed on the computer

Select if you are enabling SSO, and you are
running the Cognos Analytics Customization for
InForm wizard on the Content Manager Server.

OAM ASDK Install Location

If you are using SSO, enter the path to the
Oracle Access Management Access SDK
location.

Select Trust the user for InForm Model Generation Service (No Authentication

Required).
Click Next.

The Cognos Analytics Server Information page appears.

Enter the following information:

e IS Server—Enter the fully qualified domain name of the Cognos Analytics web server,

or browse to its location.

e Active Content Server—If you are installing a single Content Manager Server, enter
the fully qualified domain name of the server.
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If you are installing multiple Content Manager Servers, enter the fully qualified domain
name of the active Content Manager. By default, the first Content Manager computer
where you start the Cognos service is the active Content Manager.

13. Click Next.

The LDAP Configuration Information page appears.

14. Enter the following values:

Field

Description

LDAP Server

Fully qualified domain name of the server where
the Oracle Directory Server is installed.

LDAP Port

Port number used to communicate with the
LDAP server.

Administrator DN

Distinguished Name of the administrator of the
server. Use the format and values shown
beneath the field.

# Note:

The Administrator DN value
corresponds to an LDAP user who

has READ and SEARCH access to
the Base Distinguished Name (BDN).
The BDN specifies the top level or root
of the directory structure, which is the
starting place for searches.

Password, Confirm Password

Password of the administrator.

Parent Node DN

Distinguished name of the Parent Node. Use the
format shown beneath the field. (Do not enter
spaces after the commas between the parts of
the domain.)

# Note:

The Parent Node DN is also known as
the Base Distinguished Name (BDN).
The BDN specifies the top level or root
of the directory structure, which is the
starting place for searches.

Cognos Admin OU

Cognos Admin organizational unit. The value you
enter is added in Cognos as LDAP namespace
name and ID (namespace type: LDAP — Default
values for Oracle Directory Server).

15. Click Next.

The Ready to Install the Program page appears.

16. Click Install.

The Setup Status page appears and the program copies the necessary files.

ORACLE
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17. When the Wizard Complete page appears, click Finish.
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Enable Secure Sockets Layer (SSL)

In this section:

e About enabling Secure Sockets Layer (SSL)
e Set up your environment to support SSL
e Enable SSL for each study

e Set up your environment to use Transport Layer Security (TLS)

About enabling Secure Sockets Layer (SSL)

Secure Sockets Layer (SSL) enables secure communications between servers.

Enabling SSL is optional. However, Oracle recommends that you enable SSL for all Oracle
InForm installations.

If you choose to use SSL, you must set up your environment to support SSL on all servers,
and then you must enable SSL to be active in each study.

If you are using Cognos Reporting:

* You can enable SSL on the Oracle InForm servers when you install the Oracle InForm core
software.

* You can enable SSL on the Reporting servers after you install them, or wait until after the
Cognos installations are complete, and then enable SSL on all of the servers.

Set up your environment to support SSL

To enable your InForm installation to use SSL, perform the following steps on all servers.
1. Create and set up a key certificate.

2. Install key certificates.

3. Import key certificates.

4. \Verify the key certificate installation.

If you are using Reporting, perform the following additional steps on the Oracle InForm
Application Server and the Cognos Gateway Server:

1. Configure Cognos Report Server and Cognos Content Manager to use SSL.

2. Configure the Cognos Gateway Server to use SSL.

# Note:

This step is required only if you are using Reporting.
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If you choose to use SSL, you must set up key certificates on all servers, regardless of your
configuration.

e Create and set up a key certificate for SSL in IS

e Install a key certificate on the server machine in IIS

e Import the new key certificate to the local computer and the current user
«  Verify the key certificate installation

e Additional steps to perform if you are using Reporting

Create and set up a key certificate for SSL in IIS

Open Internet Information Services (1IS) Manager.
Open the <machine_name> node.
In the IIS Group, select Server Certificates.

From the Actions view, click Open Feature.

g » b PR

From the resulting Actions view, select Create Certificate Request.
The Request Certificate Wizard opens.

6. Complete the Request Certificate page. Specify the name of the study server in the
Common name field, including the FQDN (for example: <machine_name>.example.com).

7. Click Next.
8. Leave all default values in Cryptographic Service Provider Properties and click Next.
9. Click Browse.
10. Specify the certificate request name and folder details.
11. Click Open.
The file name appears in the text box.
12. Click Finish.

Install a key certificate on the server machine in lIS

ORACLE

1. Open your browser and go to the security certificate server URL: http://
<Windows_security_certificate_server>/<certificate _request_page>.

Click Request a certificate.

Click Advanced certificate request.

Click Submit a certificate request by using a base-64-encoded.

Copy all the text in certreq.txt file in the first text field of the saved request.
Click Submit.

Select Base 64 encoded.

Click Download certificate.

© ®© N o g » w Db

Save to c:\certnew.cer.

. Click Download certificate chain.
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o

11. Save to c:\certnew.p7b.

12. Go to Internet Information Services Manager to complete the certificate request.
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Select the <machine_name> node.

From the Feature View, select Server Certificate under 1IS group.

From the Actions view, select Open Feature.

From the Actions view, select Complete Certificate Request.

Browse to c:\certnew.cer and give the Friendly name as machine name, and click Next.
Set the SSL port to the port number for the study server. The default is 443.
Click OK.

Go to C:\ directory. Right click on c:\certhew.p7b.

Select Install Certificate, and click Next.

Click Next again, and click Finish.

Click Yes in the Security Warning dialog box.

Click OK on the confirmation dialog box.

Set the Binding for Default Websites.

Go to IIS Managetr.

Select the <machine_name> node.

Open the Web Sites node.

Click Edit Site > Bindings, and click Add.

Select the certificate type as Https and SSL.

Click View. Verify that there is no red exclamation mark for the Certificate.

Import the new key certificate to the local computer and the current user

ORACLE
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Click Start, type mmc, and press Enter.

From the Console screen, go to File > Add/Remove Snap-in.
Click Available snap-ins > Certificates > Add.

Select My user account, and select Finish.

Click Available snap-ins > Certificates > Add.

Select Computer account, select Next > Finish, and click OK.
Go to Certificates > Current User.

Expand Trusted Root Certification Authorities.

Right-click Certificates and select All Tasks > Import.

. Browse to the certificate you created, select it, and complete the wizard, using all defaults.

Repeat steps 8 through 10 for Certificates > Local Computer.

# Note:

Make sure <Windows_security_certificate_server> is listed in the trusted roots
of the certificate store for both the current user and the local computer. If it is
not there, export it from the current user, save it to the disk, and import it to the
local computer.
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Verify the key certificate installation

1. Open a browser window.

2. Type:

https://<machine name>.<domain name>.com

The Security Alert window appears.

3. Verify that the date and name for the certificate are valid.

Additional steps to perform if you are using Reporting

If you are using Reporting, you must configure the Cognos software and reporting servers to
use SSL.

e Configure Cognos Analytics to use SSL—Reporting only

*  Configure the Cognos Gateway Server to use SSL—Reporting only

Configure Cognos Analytics to use SSL—Reporting only

# Note:

This step is required only if you are using Reporting.

Use this procedure to update the Web Content URL and Gateway URI entries for SSL.

1. On the Cognos Report servers, select Start > Apps > Cognos Configuration.

2. After the Cognos Configuration utility is completely loaded, select Portal Services and
update the Web Content URI entry:

https://<servername>.<domainname>:<portnumber>/COGNOS11

# Note:

Be sure to change the port number to the port for HTTPS.
For example:
https://www.example.com:443/cognosll

3. Select Environment and update the Gateway URI entry:

https://<servername>.<domainname>:<portnumber>/cognosll/cgi-bin/
cognosisapi.dll
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# Note:

Be sure to change the port number to the port for HTTPS.

For example:

https://www.example.com:443/cognosll/cgi-bin/cognosisapi.dll

Select File > Save.

The Cognos Configuration utility validates the settings and saves the configuration.

5. When the checks are complete (all items are marked with a green check mark), click
Close.

6. Click Close, and close the Cognos Configuration utility window.

Configure the Cognos Gateway Server to use SSL—Reporting only

< Note:

This step is required only if you are using Reporting.

If you install Cognos Analytics on its own dedicated server, you must configure IIS to work with
Windows 2012 and 2019.

On the server where the Cognos Analytics Gateway services are installed:

1. Navigate to Start > Administrative Tools > Internet Information Services (IIS)
Manager, and expand the node for the local computer.

2. Select ISAPI and CGI Restrictions.

3. Make sure that the following options are set to Allowed:

All unspecified CGIl modules.
All unspecified ISAPI modules.
ASP.NET v2.0.50727.
ASP.NET v4.0.30319.
WebDAV.

Active Server Pages.

Enable SSL for each study

If you choose to use SLL, you must enable SSL to be active for each study.

ORACLE

After you complete the InForm installation and set up your environment to support SSL, you

must

e Enable the SSL System Configuration option for each study.
You can set this option in the Oracle InForm Admin user interface or with the MedML
Installer utility.
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Configure Oracle InForm web services to enable SSL.

Enable SSL through the Oracle InForm Admin user interface
Enable SSL with the MedML Installer utility

Configure the Oracle InForm study web services to use SSL

Enable SSL through the Oracle InForm Admin user interface

1
2
3.
4

o

Log in to the Oracle InForm application as a user with system administration rights.
Click Admin > Configuration.
Set the Enable SSL option to on.

If you are setting up the Reporting and Analysis module, change the Reporting service
full url option to start with https:// and to include a port number.

Click Update.
Stop and restart the study with the following commands.

pfadmin stop trial <studyname>
pfadmin start trial <studyname>

Enable SSL with the MedML Installer utility

1.

Create an XML file with the following entry:

<MEDMLDATA>

<SYSCONFIG CONFIGNAME="SSLFLAG" TYPE="0" VALUE="1" />
<MEDMLDATA/>

If you are setting up the Reporting and Analysis module, include the following definition in
the XML file, and change the value of the URL for the reporting server to start with https://.

<SYSCONFIG CONFIGNAME="REPORTINGSERVER" TYPE="0" VALUE="https://<url>" />
Stop the study with the following command:
pfadmin stop trial <studyname>

Install the configuration options with the MedML Installer utility.
For more information, see the Ultilities Guide.

Restart the study with the following command:

pfadmin start trial <studyname>

Configure the Oracle InForm study web services to use SSL

Use the pfadmin command to configure the active web services for each study:

pfadmin config webservice <studyname> <webservicename> ADD HTTPS:<port>
cert:<thumbprint>

ORACLE
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For example to configure the DeploymentService, AuthService, and ODMSubmitService web
services for pfst62:

pfadmin config webservice pfst62 DeploymentService ADD HTTPS:14040
cert:73616d706c657468756d627072696e74

pfadmin config webservice pfst62 AuthService ADD HTTPS:14041
cert:73616d706c657468756d627072696e74

pfadmin config webservice pfst62 ODMSubmitService ADD HTTPS:14042
cert:73616d706c657468756d627072696e74

For more information, see Step 3: Set up a skeletal study and pfadmin.

Set up your environment to use Transport Layer Security (TLS)

To enable Transport Layer Security (TLS):
1. Create the following Windows registry keys:

e HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\SecurityProviders\SCH
ANNEL\Protocols\TLS 1.2

e HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\SecurityProviders\SCH
ANNEL\Protocols\TLS 1.2\Client

e HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\SecurityProviders\SCH
ANNEL\Protocols\TLS 1.2\Server

2. For the Client and Server entries, enter the following DWord and Value entries:
e DisabledByDefault=00000000
*  Enabled=00000001
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In this chapter:

Post-installation tasks

Deploy your study

Uninstalling software components

Command and script reference

Troubleshooting

Running the Cognos Customization wizards in silent mode

Typical rights for CRA and CRC rights groups



Post-installation tasks

In this section:

Enable communication among distributed Cognos Analytics software components
Enabling clinical model generation in a multi-server environment

Start the Cognos Analytics servers

Disable the indexed search option on the Reporting Server

Enabling Authors group permissions

Configure settings for Comma Separated Values (CSV) report output

Deploying SQL profiles

Additional Cognos information

Apply the Oracle InForm Publisher safety workaround (optional)

Enable communication among distributed Cognos Analytics
software components

If you install one or more Application Tier Components on a separate server, perform the these
actions to ensure that they can communicate with other Cognos Analytics reporting
components.

Configure cryptographic properties.

Specify all Content Manager URIs.

Specify the Dispatcher URIs.

Specify the Dispatcher URI for external applications.

Configure the Cognos Report Server Notification Store property to point to the Content
Store database. This is described in the online Help notes in the Cognos Configuration

utility.

# Note:

This is only necessary if you are using a multiple server environment where the
Cognos Report Server and the Cognos Content Manager are on separate
servers.

For more information, see the Cognos Analytics documentation.

Enabling clinical model generation in a multi-server environment

If your Cognos environment contains multiple Cognos servers, set the following on all the
dispatchers:

ORACLE
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Log in to Cognos with an administrator account.

Open IBM Cognos Administration.

On the Configuration tab, click Dispatchers and Services.

A list of the dispatchers that are registered with the Content Manager appears.

For each dispatcher, perform these steps:

Click the Set Properties button (E) and then click Settings.

a.
b. Inthe Category drop-down list, select Tuning.

0

Set the Load balancing mode property to Cluster Compatible.
d. Click OK.

Start the Cognos Analytics servers

After completing the Cognos Analytics installation and configuration steps, you can start the
Cognos Analytics servers. If you have distributed Cognos Analytics application tier
components across multiple servers, see the Cognos Installation & Configuration Guide for the
specific order for starting the servers.

1.

2.
3.

On the server where the Cognos Analytics service is installed, select Start > Apps > IBM
Cognos Configuration.

The Cognos Configuration utility starts.
Select Actions > Start.

When the server is started, close the Cognos Configuration utility.

Disable the indexed search option on the Reporting Server

Because the indexed search functionality is not available in the Reporting and Analysis
module, you should make the following adjustment to the user interface to hide the option:

ORACLE

® N o o

# Note:

If you have distributed Cognos Analytics application tier components across multiple
servers, perform this procedure on each presentation server.

Log in to the Cognos server with an administrator account.

Open IBM Cognos Administration.

On the Configuration tab, click Dispatchers and Services.

A list of the dispatchers that are registered with the Content Manager appears.

Select the PresentationService entry.

In the Actions column, click the Set Properties button (E).
Click the Settings tab.
For Environment, Advanced settings, click Edit.

Select Override the settings acquired from the parent entry, and do the following:
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Enabling Authors group permissions

e In the Parameter column, enter portal.disableindexsearch.
e Inthe Value column, enter true.
Click OK.

10. Restart the Cognos service.

Enabling Authors group permissions

By default, the Authors Oracle InForm Reporting group restricts users from including HTML
items and user-defined SQL when creating reports.

For on-premises customers in a self-hosted environment, these default permissions can be
modified to remove these restrictions in the Cognos Administration module:

1.
2.

7.

Login as a Cognos system administrator.

Go to Manage > People > Capabilities.

A search box appears.

Search for and select Edit User Defined SQL permission.
Open the menu and click Customize Access.

Remove the All Authenticated Users group by clicking the minus (-) button. Confirm the
deletion.

Add the Authors group to Edit User Defined SQL permission by clicking the plus (+) button.
e Click Cognos.

e Search for and select the Authors group.

e Click the plus (+) button to assign the Access permission to the group.

Repeat steps 3 to 6 to add the Authors group to the Edit HTML Items permission.

All users belonging to the Authors group will now be able to make changes to user-defined
SQL and HTML items.

< Note:

If implemented, this customization should be re-assessed for potential impact
following any version upgrade for IBM Cognos Analytics, and dependent on future
changes in the Cognos security or permissions model, may require to be re-applied
or revised. For more information,, please see the IBM Cognos Analytics
documentation.

Allowing support for restricted report elements

Allowing support for restricted report elements

You may need to give a support user the ability to troubleshoot Report Studio reports that
contain either restricted element.

ORACLE

For a user to troubleshoot reports containing custom HTML or SQL, the user must:

Be a Support user type.

Be a member of the following Reporting Groups:
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— Directory Administrators
— Ad Hoc Users
— Sponsor Users

* Not be a member of the Authors Reporting group.

Configure settings for Comma Separated Values (CSV) report

output

The Reporting and Analysis module provides settings that allow you to easily use CSV report
output files with applications such as the Excel spreadsheet application. Oracle applies these
settings for hosted environments, and recommends that you apply them to your environments
as well.

# Note:

You must have server administration rights to modify these settings.

» Delimiter—Comma-delimited files are widely accepted for use with several applications.

* Encoding—Using UTF-8 character encoding allows you to use your CSV output with a
wide range of applications.

e Terminator—Using carriage return and line feed (CRLF) terminators ensures that the
report output is properly organized into columns and rows.

e Configure the CSV settings for reports

Configure the CSV settings for reports

ORACLE

1. Log in to the Cognos server with an administrator account.
2. Open IBM Cognos Administration.
3. On the Status tab, in the pane on the left, click System.
4. Inthe Scorecard section, click the server name.
The full URL for the server appears below the server name.
5. Click the full URL for the server.
The available services for the server appeatr.
6. Select Report Service > Set Properties.
The Set properties - ReportService dialog box appears.
7. Select the Settings tab.
8. Inthe Category drop-down list, select Environment.
9. Inthe Environment category, in the Advanced settings row, click Edit.
The Set advanced settings dialog box appears.
10. Select Override the settings acquired from the parent entry checkbox.

11. Type the following parameters and values:
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Parameter Value Description
RSVP.CSV.DELIMITER N/A Separates each data item in the
report output with a comma.
RSVP.CSV.ENCODING UTF-8 Specifies UTF-8 character
encoding for report data.
RSVP.CSV.TERMINATOR CRLF Separates each row of data with

a carriage return and line feed,
so that the rows appear in
ordered columns.

12. Select the checkbox next to each parameter.
13. Click OK.

The Set properties - ReportService page appears.

14. Click OK.

Deploying SQL profiles

SQL profiles can be used to improve performance.
To deploy SQL profiles:

ORACLE

1.

Unzip InForm_SQLProfiles.zip (located in the
<Installation_Directory>\InForm\Bin\DBOra\ReviewSchema folder).

Connect to SQLPIlus as a user with the proper privileges:
* ADVISOR role

e CREATE ANY SQL PROFILE PRIVILEGE

e ALTER ANY SQL PROFILE PRIVILEGE

*  DROP ANY SQL PROFILE PRIVILEGE

e EXECUTE PRIVILEGE ON DBMS_SQLTUNE

# Note:

The user can be of any type, such as system user or pfdbadmin user, as long as
a sys user has granted them the proper privileges.

Create a staging table in the destination database.

EXEC DBMS SQLTUNE.CREATE STGTAB SQLPROF (table name =>
"STGTAB_ SQLPROF DB006');

Import the data to the destination database.

imp <user>/<pwd>@<instance> tables=('STGTAB SQLPROF DB006') file=
InForm SQLProfiles.dmp log=imp.log ignore=y

Create SQL Profiles in the destination database using the data stored in the staging table.

EXEC DBMS SQLTUNE.UNPACK STGTAB SQLPROF (replace => TRUE,
staging table name => 'STGTAB SQLPROF DB006');
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6. Verify that the profiles imported correctly.

Select name, created from dba sql profiles;

Additional Cognos information

For information on any additional post-installation tasks related to the supported Cognos
patches and versions, please refer to the latest applicable Oracle InForm Reporting Cognos
Installation Guide listed under Cognos documentation on the Oracle Help Center.

Apply the Oracle InForm Publisher safety workaround (optional)

" Note:

This workaround only applies if the RuleEventFxns2.dll file found the
D:\OracleHS\InForm\Trials\<STUDY_NAME>\RuleAssemblyVersion_* folders is
version 2.0.0.203.

To verify the version of the DLL file, right-click on the file and select Properties.

1. Copy RuleEventFxns2.dll from E:\OracleHS\InForm\Bin\RulesWorkaround\

2. Replace the DLL file under the
D:\OracleHS\InForm\Trials\<STUDY_NAME>\RuleAssemblyVersion_* folders.

3. Make sure the backup is created outside of the
D:\OracleHS\InForm\Trials\<STUDY_NAME> folder.

ORACLE -


https://docs.oracle.com/en/industries/life-sciences/inform/inform7gs.html

Deploy your study

ORACLE

After you have installed and configured the Oracle InForm software and the Reporting and
Analysis module, you can schedule an automated study deployment from the Oracle Central
Designer application.

There are two ways to schedule an automated study deployment:

* Inthe Oracle Central Designer user interface, a Oracle Central Designer user can
schedule and monitor the progress of a study deployment. This is the preferred
deployment method.

For more information, see the Oracle Central Designer User Guide.

* Inthe Oracle InForm user interface, a sponsor user with the Deployment right can log in to
a study, select a deployment package, and schedule a time to run the deployment.
For more information, see the User Guide for Sponsor Users.

To complete the configuration process, see the Study and Reporting Setup Guide. The Study
and Reporting Setup Guide describes how to perform the tasks that are required to set up an
Oracle InForm study and configure the Reporting and Analysis module for the study.
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Uninstalling software components

In this section:

About uninstalling software components

Uninstalling the Cognos Customization for Oracle InForm and the Cognos Gateway
Customization for Oracle InForm wizards

Uninstalling the Cognos Analytics software
Uninstalling the Oracle Directory Server

Uninstalling the Oracle InForm software

About uninstalling software components

This section describes how to uninstall the core Oracle InForm software, the Cognos Analytics
software, and the customizations for Cognos Reporting. For information about removing the
reporting elements and an Oracle InForm study, see the Study and Reporting Setup Guide.

Uninstall the Oracle InForm and Cognos Analytics software in the following order:

1.

2.
3.
4,

The Cognos Customization for Oracle InForm wizard, the Cognos Gateway Customization
for Oracle InForm wizard, and the Oracle InForm Reporting Database scripts.

The Cognos software.
The Oracle Directory Server.

The Oracle InForm software.

If any errors occur during the Oracle InForm software uninstallation, the default location where
error logs are saved is C:\Program Files (x86)\Oracle HS \InForm <release version>\InForm
<release version><build_number>\InstallLogs. The file nhame for the error logs is Install_yyyy-
mm-dd_hh-mm-ss.log.

Uninstalling the Cognos Customization for Oracle InForm and the
Cognos Gateway Customization for Oracle InForm wizards

To uninstall the files loaded with the Cognos Customization for Oracle InForm wizard, you
uninstall the Cognos Gateway Customization for InForm wizard.

ORACLE

1.

On the server where the Cognos Gateway Customization software is installed, select Start
> Control Panel > Programs and Features.

Select the Cognhos Gateway Customization for InForm entry, and click Uninstall.
The Cognos Gateway Customization for Oracle InForm installation wizard starts.
When the confirmation message appears, click Yes.

When the wizard is complete, click Finish.
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Uninstalling the Cognos Analytics software

The Cognos Uninstall Wizard enables you to uninstall the Cognos Analytics core software and
the Cognos Analytics SDK software. You can uninstall both components together if they are on
the same server or uninstall each component separately.

1.

On the server that hosts the Cognos Analytics software, select Start > Apps > Uninstall
IBM Cognos Analytics.

The Uninstall Wizard starts.

On the Uninstall Language Selection page, select the language you want to use to run the
uninstall, and click Next.

On the next page, select the component packages to uninstall, and click Next.
The uninstall process starts.

When the wizard is complete, click Finish.

# Note:

The uninstall may leave some folders and files on the computer. You can delete
these with the Windows Explorer application.

Uninstalling the Oracle Directory Server

See the Oracle Directory Server Enterprise Edition documentation, or your Oracle database
documentation for instructions on uninstalling the Oracle Directory Server.

Uninstalling the Oracle InForm software

ORACLE

1
2
3.
4

o

Stop all Oracle InForm servers and studies.

Stop the Oracle InForm Service.

From the Windows Control Panel, open Programs and Features.

Select Oracle InForm <release version> and click Uninstall.

A confirmation dialog box appears.

Click Yes.

If a message appears and asks if you want to remove shared files, click No to All.
A message reminds you to back up customized files before continuing.

To stop uninstalling the software so that you can back up the customized files, click No.
or

To continue, click Yes.

When the uninstall is complete, the Reboot page appears.

Click Finish.

The computer reboots.

10-2



Command and script reference

In this appendix:

e AdminDBWithDDL

e exportdb

e importdb

e create_cap_table.sql

* DecomTrial

e DeployBackup.cmd

e DeployEnd.cmd

e DeployRestore.cmd

e ExportMigrationFiles

e ImportMigrationFiles

e grant_dba_privs.sql

e grant_user_privs.sql

e ImportUtility

e informprepora

e pfadmin

e pfcognosconfig

e pfrinit

e PostDeployWorkaround.cmd
e PreDeployWorkaround.cmd

e RequestTime.cmd

AdminDBWithDDL

ORACLE

Purpose

Creates the Oracle InForm Admin database if you did not set it up during the Oracle InForm

core software installation by selecting the Install Admin DB checkbox.

Location

<Installation_Directory>\InForm\bin\DBOra folder.

Usage

AdminDBWithDDL [connection string] [dbadmin-uid] [dbadmin-pass] [pfdbadmin-uid]
[pfdbadmin-pass] [inform-tablespace] [inform-lob-tablespace]

AdminDBWithDDL [connection string] /prompt
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AdminDBWithDDL

AdminDBWithDDL [connection string] laccountparams:[parameterfile]
Where:

* connection string—Database TNS Instance name.

¢ dbadmin-uid—Oracle InForm Admin Database UID (User name).
* dbadmin-pid—Oracle InForm Admin Database PID (Password).
« pfdbadmin-uid—pfdbadmin Database UID.

* pfdbadmin-pass—pfdbadmin Database PID.

* inform-tablespace—Tablespace in database for normal Oracle InForm objects. For
example, INFORM.

* inform-lob-tablespace—Tablespace in database for large inform objects. For example,
INFORM_LOB.

« parameterfile—Path to text file containing parameters.

Command line prompts
If using prompting, you are prompted for the following parameters:

* dbadmin-uid—Oracle InForm Admin Database UID (User name).
* dbadmin-pid—Oracle InForm Admin Database PID (Password).
« pfdbadmin-uid—pfdbadmin Database UID.

« pfdbadmin-pass—pfdbadmin Database PID.

» inform-tablespace—Tablespace in database for normal Oracle InForm objects. For
example, INFORM.

« inform-lob-tablespace—Tablespace in database for large inform objects. For example,
INFORM_LOB.

Parameter file contents

When using a parameter file, the path to a text file is given. The format of the parameter file is
parameter=value, with each value on a separate line, and no spaces between the parameter
name, =, and value.

The parameter file must contain the following parameters:
¢ AdminDbUid=[dbadmin-uid]
AdminDbPid=[dbadmin-pid]

e pfdbauid=[pfdbadmin-uid]

»  pfdbapid=[pfdbadmin-pid]

* inftablespace=[inform-tablespace]

* inflobtablespace=[inform-lob-tablespace]

Example
*  AdminDBWithDDL triall /prompt
* AdminDBWithDDL triall /accountparams:myparams.txt

*  AdminDBWithDDL triall informadmin myinformadminpassword pfdbadmin
mypfdbadminpassword INFORM INFORM_LOB
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exportdb

Purpose

Exports the given database schema.

Location

<Installation_Directory>\InForm\bin\DBOra folder.

Usage
exportdb [connection string] [dump-file-directory-path] [dump-file-name] /prompt [log options]

exportdb [connection string] [dump-file-directory-path] [dump-file-name] /accountparams:
[paramfile] [log options]

exportdb [connection string] [dump-file-directory-path] [dump-file-name] [version] /prompt [log
options]

exportdb [connection string] [dump-file-directory-path] [dump-file-name] [version] /
accountparams:[paramfile] [log options]

Where:

Parameter Description

connection-string Database TNS Instance Name
dump-file-directory-path Physical path on database server where the dump

should be created. The path must conform to the
proper OS path format, and that it should be
expected that the path is case-sensitive.

dump-file-name Filename to give the exported dump file. Note that
the name must conform to the proper OS format for
the database server, and that it should be expected
that the name is case-sensitive.

version Target database version. Only specify if the dump
will be imported into a lower version database.

paramfile Path to text file containing the list of parameters.
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Parameter

Description

log options

Optional

parameters for specifying the log file name

and/or location.

The log f
The log f

ile defaults to being named ExportDB.log.
ile path defaults to the current working

directory.

Options:
 JLog

 JLog

 JLog

File:[filespec]

filespec = fully qualified name and path for
created log file. If a relative path is given,
it is based from the current working folder.
Overrides the logfile-path to be the
resolved path to the given filespec.
Overrides the logfile-name to be the
resolved name of the given filespec.

Do not specify this if either of the other
logging options are specified.
FilePath:[pathspec]

pathspec = fully qualified path to create
the log file in. If a relative path is given, it
is based from the current working folder.
Overrides the logfile-path to be the
resolved path to the given pathspec.
Does not change logfile-name.
FileName:[filename]

filespec = Filename for the log file.
Overrides the logfile-name for the log file.
Does not change logdfile-path.

Command line prompts

If using prompting, you are prompted for the following parameters:

Parameter file contents

Schema Owner User ID—Database trial/schema owner user ID.

Database Administrator User Name—Name of the Database Administrator User (for

example, pfdbadmin).

Database Administrator User Password—Password for the Database Administrator

User.

When using a parameter file, the path to a text file is given. The format of the parameter file is
parameter=value, with each value on a separate line, and no spaces between the parameter

name, =, and value.

The parameter file must contain the following parameters:

trial_user—Schema Owner User ID.

admin_user—Database Administrator User Name.

admin_user_pass—Database Administrator User Password.
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Example

exportdb triall /backups backup.dmp /prompt

exportdb triall /backups backup.dmp /accountparams:myparamfile.txt

exportdb triall /backups backup.dmp /prompt /logfilepath:c:\exportlogs

Purpose

Imports the given database schema.

Location

<InstallationDirectory>\InForm\Bin\DBOra folder.

Usage

importdb [connection-string] [dump-file-directory-path] [dump-file-name] [from-userid] /Prompt
[log options] [/AdditionalParametersFile:optionsfile] [/NotTrial]

importdb [connection-string] [dump-file-directory-path] [dump-file-name] [from-userid] /
AccountParams:[paramfile] [log options] [/AdditionalParametersFile:options-file] [/NotTrial]

Where:

Parameter Description

connection-string Database TNS Instance Name.
dump-file-directory-path Physical path on database server where the dump

is located.

# Note:

The name must
conform to the proper
OS format for the
database server, and
the name is expected
to be case-sensitive.
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Parameter

Description

dump-file-name

Filename of the dump file to import.

# Note:

The name must
conform to the proper
OS format for the
database server, and
the name is expected
to be case-sensitive.

from-userid

Original schema owner User ID when exported.

paramfile

Path to text file containing the list of parameters.

log-options

Optional parameters for specifying the log file name
and/or location.

The log file defaults to being named ImportDB.log.

The log file path defaults to the current working
directory.

Options:

e /LogFile:[filespec]

filespec = fully qualified name and path for
created log file. If a relative path is given,
it is based from the current working folder.
Overrides the logfile-path to be the
resolved path to the given filespec.
Overrides the logfile-name to be the
resolved name of the given filespec.

Do not specify this if either of the other
logging options are specified.

*  /LogFilePath:[pathspec]

pathspec = fully qualified path to create
the log file in. If a relative path is given, it
is based from the current working folder.
Overrides the logfile-path to be the
resolved path to the given pathspec.
Does not change logfile-name.

* /LogFileName:[filename]

filespec = Filename for the log file.
Overrides the logfile-name for the log file.
Does not change logfile-path.

ORACLE
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Parameter Description

options-file Path to a text file containing list of additional import

parameters. These options are added to the default
import parameters, allowing customization of the
import operation.

Operations such as remap_schema and
remap_tablespace may be added to the file, each
on a separate line, with no intervening spaces.

For example:

remap_schema=oldschemaownerid:newschemaow
nerid

remap_tablespace=oldtablespacename:INFORM

See the impdp documentation for details on import
options.

/NotTrial Prevents pre-import tablespace analysis of the

schema prior to importing.

This behavior is only supported for Trial Schemas,
and should be prevented through this parameter for
any other type of schema being imported.

Command line prompts

If using prompting, you are prompted for the following parameters:

To User Schema Owner User ID—Database trial/schema owner user ID for the schema
to which the dump should be imported.

To User Schema Owner User Password—Password for the schema owner user. The
password must conform to local restrictions.

Database Adminstrator User Name—Name of the Database Administrator User (for
example, pfdbadmin).

Database Administrator User Password—Password for the Database Administrator
User.

Parameter file contents

When using a parameter file, the path to a text file is given. The format of the parameter file is
parameter=value, with each value on a separate line, and no spaces between the parameter
name, =, and value.

The parameter file must contain the following parameters:

Trial_user—Trial/Schema Owner User ID for the schema to which the dump should be
imported.

Trial_user_pass—Trial/Schema Owner User Password. Password must conform to local
restrictions.

Pfdbadmin_user—Name of the InForm Database Administrator User (for example,
pfdbadmin).

Pfdbadmin_user_pass—Password for the InForm Database Administrator User.

The parameter file may contain the following parameters:
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* AdditionalParametersFile—options-file—Ildentical to specifying on the command line.
See command line parameter explanation for details. Only one additional parameter file
may be specified, either on the command line or in the parameter file, not both.

Example

importdb triall /backups backup.dmp pfst63uid /prompt
importdb triall /backups backup.dmp pfst63luid /accountparams:myparamfile.txt

importdb triall /backups backup.dmp pfst6211 /prompt /
logfilepath:c:\exportlogs

importdb triall /backups other.dmp oldotherschemuid /prompt /nottrial

create_cap_table.sql

Purpose

Creates the TRIAL_URLS table for the PFCAPAdmiIn user.

Location

Folder where the reporting software is located, for example,
<Installation_Directory>\InForm\bin\DBOra\Reporting.

Usage

@create_cap_table.sql

Notes
Run from SQL*Plus with /nolog.

Errors are recorded in the create_cap_table.log file.

# Note:

The Oracle InForm database installation and administration scripts are designed to
be run using the Oracle InForm Application Server. The scripts can also be run from
the Oracle database home on an Oracle InForm Reporting Server. Running them
from a different Windows Oracle client or from a non-Windows Oracle client or
database home may work, but is not supported.
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DecomTrial

ORACLE

Purpose

Securely removes Oracle InForm study components (study folders, clinical package,
operational package, DSN entries, and Oracle InForm study user accounts) from the Reporting
and Analysis module.

Location

The Oracle InForm application server folder on the Oracle InForm application server. For
example, <Installation Directory>\InForm\bin.

Usage

DecomTrial [SysAdminNamespace SysAdminUsername TrialNamespace TrialUsername
CognosDispatcherURI TrialName [<company_code>]]

Option Parameter

SysAdminNamespace Oracle Directory Server admin namespace.
SysAdminUsername User name for the Cognos system administrator.
TrialNamespace Custom Authentication Provider (CAP) namespace.

Enter informcap.

TrialUsername Oracle InForm study user who is a member of the
following Reporting groups:
e Publishers.

e Either Sponsor Users or Site Users.

CognosDispatcherURI Internal URI that the Oracle InForm server uses to
communicate with the Cognos Analytics server.

TrialName Name of the Oracle InForm study.

company_code The organization ID. Optional.

This parameter is required only for Oracle-hosted
studies in a single sign-on environment.

Command line prompts

Depending on the syntax used with the DecomTrial command, you are prompted for the
following parameters:

e System Administrator namespace—Oracle Directory Server admin namespace.
e System Administrator username—User name for the Cognos system administrator.

e Trial namespace name—Custom Authentication Provider (CAP) namespace. Enter
informcap.

e Trial user username—Oracle InForm study user who is a member of the following
Reporting groups:

— Publishers.
— Either Sponsor Users or Site Users.

e Cognos dispatcher URL—Internal URI that the InForm server uses to communicate with
the Cognos Analytics server.

e Trial name—Study name.
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e« Company Code—The organization ID.
Optional. Reserved for Oracle-hosted studies in a single sign-on environment.

* System Administrator password—Password for the Cognos system administrator.

e Trial user password—Password for the Oracle InForm study user.

# Note:

You are always prompted for the System Administration password and Trial user
passwords when you run DecomTrial.

For legacy purposes, you can also pass the parameters by using the /
accountparams:‘path_to_parameter_file" command option.

When specified, this option includes the path to a text file that contains the values required to
run the command. The format of the parameter file is parameter=value. There is a new line for
each parameter, and there are no spaces on a line.

Parameter file contents
You can pass the following parameters in a parameter file:

e sysadmin_namespace=0racle Directory Server admin namespace.

e sysadmin_uid=User name for the Cognos system administrator.

e trial_namespace=Custom Authentication Provider (CAP) namespace. Enter informcap.
e trial_user=Study user.

e dispatcher_url=Internal URI that the InForm server uses to communicate with the Cognos
Analytics server.

e trial_name=Study name.

e company_code=0rgID assigned for an single sign-on study.

Example

DecomTrial OHSI crnsysadmin informcap mmartin http://server.example.com:9300/p2pd/
servlet/dispatch pfstcardio blank

DeployBackup.cmd

ORACLE

Purpose

Backs up a study under a custom archive file name and path. If the operation is successful, the
command returns 0. Otherwise, it returns 1 to signal the error.

Location

Deployment root folder, as defined in the DeployRoot registry value under
HKEY_LOCAL_MACHINE\SOFTWARE\OracleHS\InForm. By default, it is the InFormDeploy
folder on the drive where the InForm application is installed. For example: E:\InFormDeploy.
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DeployBackup <Study_Name> <Archive_File_Name> <TNS_Service_Name> <Archive_Path>

<Parameters_File _Name>

Option

Parameter

Study_Name

Name of the study to be backed up.

Archive_File_Name

Name of the backup file.

TNS_Service_Name

Local Net Service Name for the remote database
service.

Archive_Path

Path on the database server where the backup file
is saved.

Parameters_File_Name

Name of the parameters file that contains database
credentials.

The parameters file must contain the following
values:

trial_user=<study_schema_user_name>
trial_user_pass=<study_schema_user_password>
orasystem_user=<admin_user_name>
orasystem_user_pass=<admin_user_password>

DeployEnd.cmd

Purpose

Applies custom system tasks after a successful or failed study deployment. If the operation is
successful, the command returns 0. Otherwise, it returns 1 to signal the error.

Location

Deployment root folder, as defined in the DeployRoot registry value under
HKEY_LOCAL_MACHINE\SOFTWARE\OracleHS\InForm. By default, it is the InFormDeploy
folder on the drive where the InForm application is installed. For example: E:\InFormDeploy.

Usage

DeployEnd <Study_Name> <Deployment_Status>

Option

Parameter

Study_Name

Name of the deployed study.

Deployment_Status

e 0 for successful study deployment
* 1 for failed study deployment

DeployRestore.cmd

Purpose

Restores a backed up study from a specified archive file. If the operation is successful, the
command returns 0. Otherwise, it returns 1 to signal the error.

ORACLE
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Location

Deployment root folder, as defined in the DeployRoot registry value under
HKEY_LOCAL_ MACHINE\SOFTWARE\OracleHS\InForm. By default, it is the InFormDeploy
folder on the drive where the InForm application is installed. For example: E:\InFormDeploy.

Usage

DeployRestore <Study_Name> <Archive_File_Name> <TNS_Service_Name> <Archive_Path>
<Parameters_File_Name>

Option Parameter

Study_Name Name of the study to be restored.

Archive_File_Name Name of the backup file.

TNS_Service_Name Local Net Service Name for the remote database
service.

Archive_Path Path on the database server where the backup file
is saved.

Parameters_File_Name Name of the parameters file that contains database
credentials.
The parameters file must contain the following
values:

trial user=<study schema user name>

trial user pass=<study schema user pa
ssword>

orasystem user=<admin user name>

orasystem user pass=<admin user passw
ord>

ExportMigrationFiles

ORACLE

Purpose
Exports the Oracle InForm study and related configurations for migration.

Creates the database dump(s) as named on the database server in the given location, creating
logs and export files in the specified log folder.

< Note:

The ExportMigrationFiles command copies the InForm Publisher configuration, if it is
present.
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Location

<Drive:>\OracleHS\InstallSupport

Usage

Chapter 11
ExportMigrationFiles

ExportMigrationFiles [connection string] /prompt [log options]

ExportMigrationFiles [connection string] /accountparams:[paramfile] [log options]

Where:

Parameter

Description

connection-string

Database TNS Instance Name

paramfile

Path to text file containing the list of parameters.

log options

Optional parameters for specifying the log file name
and/or location.

The log file defaults to being named
ExportMigrationFiles.log.

The log file path defaults to the current working
directory.

Options:

*  /LogFile:[filespec]

— filespec = fully qualified name and path for
created log file. If a relative path is given,
it is based from the current working folder.

—  Overrides the logfile-path to be the
resolved path to the given filespec.

—  Overrides the logfile-name to be the
resolved name of the given filespec.

— Do not specify this if either of the other
logging options are specified.

*  /LogFilePath:[pathspec]

— pathspec = fully qualified path to create
the log file in. If a relative path is given, it
is based from the current working folder.

— Overrides the logfile-path to be the
resolved path to the given pathspec.

— Does not change logfile-name.

* /LogFileName:[filename]

— filespec = Filename for the log file.

— Overrides the logfile-name for the log file.

— Does not change logfile-path.

Command line prompts

You are prompted for the following parameters:

Oracle InForm Database Adminstrator User Name—Name of the Oracle InForm
Database Administrator User (for example, pfdbadmin).

Oracle InForm Database Administrator User Password—Password for the Oracle

InForm Database Administrator User.

Trial Schema Owner User ID—Trial database schema owner user ID.

Trial Schema Owner User Password—Trial database schema owner's password for the

study.
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« Database Dump File Directory Path—Location on the Oracle InForm Database Server
where the dump file(s) are to be created. Must conform to the Database Servers path
format (such as, path separators are \ on Windows, / on Linux).

# Note:

The physical path must exist before you run the ExportMigrationFiles command.

e Trial Database Dump Name—File name for the Trial Schema Database Dump that is
being created. If not specified, it will be defaulted to <trial-schema-owner-id>.dmp.

Parameter file contents

When using a parameter file, the path to a text file is given. The format of the parameter file is
parameter=value, with each value on a separate line, and no spaces between the parameter
name, =, and value.

The parameter file must contain the following parameters:

- Pfdbadmin_user—Name of the Oracle InForm database administrator (for example,
pfdbadmin).

* Pdbadmin_user_pass—Password for the Oracle InForm database administrator user.
e Trial_user—Trial/Schema Owner User ID for the study to export.
e Trial_user_pass—Password for the Trial/Schema Owner User for the study to export.

« Dump_file_dir_path—Location on the Database Server where the import dump file(s) are
located.

The parameter file may contain the following parameters:

e Dump_file_name—Trial Schema dump filename. If not specified, uses the default of
[trial_user].dmp.

« Schemas—Comma delimited list of integration and/or additional schemas to be exported
with the trial schema. Additional schemas are specified by their Schema Owner User ID
and are exported with the fixed name [schema-owner-user-id].dmp to the same
dump_file_dir_path that the trial schema is exported to.

# Note:

The Database Administrator user must have the rights necessary to export any
schemas listed.

# Note:

Do not include spaces in the dump file name or the directory path to the dump
file.

Example

ExportMigrationFiles triall /prompt
ExportMigrationFiles triall /accountparams:exportparams.txt
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ExportMigrationFiles triall /prompt /logfilepath:c:\trialexport
ExportMigrationFiles triall /accountparams:exportparams.txt /
logfilepath:c:\trialexport

Notes
The following logs are created in the log files path:

* ExportMigrationFiles.log—The file contains the output of the actions performed by the
ExportMigrationFiles.cmd file.

* ExportDB.log—Log generated during the trial schema database export.

* INF-19122_DetectMnemonicLength.log—Output from the Mnemonic Length validation
script.

Exported files will be located in a subdirectory of the log files path named ExportFiles. This
folder contains the files that will need to be copied to the target Application Server for the
Migration. The Export files created in this folder are:

* InFormRegistryBackup.txt—Exported Oracle InForm registry

» pfadmin_view_service.txt—Text file containing the information for the servers and
studies running on the Oracle InForm Application Server.

* ImportParametersTemplate.txt—Example import parameters file with most entries filled
in. Requires editing prior to use. There are at a minimum four (4) lines that will need to be
edited, all at the top of the file, replacing the bracketed descriptions with the actual
settings:

— trial_user_pass=[trial_user_pass]

— pfdbapid=[pfdbapid]

— dump_file_dir_path=[dump_file_dir_path]

— deployment_backup_folder=[deployment_backup_folder]

Other settings in the file may be edited, including the trial name, server name, and so on.

* InFormPublisher.config—Oracle InForm Publisher Configuration file. Only included if
Oracle InForm Publisher is configured.

* nepWslc.txt—Oracle InForm Publisher Configuration Key file. Only included if Oracle
InForm Publisher is configured.

The database dump files must be copied from the source database server to the target
database server, and placed in the dump_file_dir_path specified in the import parameters.
These files must all have permissions set such that they are readable by all users.

# Note:

If error messages indicating that the system cannot find the paths specified for the
System Product Locale and the System Study Locale appear, disregard the
messages and continue with the migration.
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ImportMigrationFiles

ORACLE

Purpose

Imports an Oracle InForm study database dump file that was created by the
ExportMigrationFiles command into a new database instance, and creates and configures the
InForm study based on command parameters supplied when the command runs.

# Note:

The ImportMigrationFiles command registers the study with Oracle InForm (if the
Oracle InForm Adapter parameters are all specified), and with Oracle InForm
Publisher (if the Oracle InForm Publisher parameters are provided).

Location

<InstallationDirectory>\InForm\Bin\DBOra

Usage

ImportMigrationFiles [connection string] /prompt [/AdditionalParametersFile:[optionsfile]] [/
IgnoredimportErrorsFile:[ignorederrors]] [log options] [/resume:resumelabel]

ImportMigrationFiles [connection string] /accountparams:[paramfile] [/
AdditionalParametersFile:[optionsfile]] [/IgnoredimportErrorsFile:[ignorederrors]] [log options] [/
resume:resumelabel]

Where:

Parameter Description

connection-string Database TNS Instance Name

paramfile Path to text file containing the list of parameters.
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Parameter Description

optionsfile Optional path to text file containing list of additional
import parameters. These options are added to the
default import parameters, allowing customization
of the import operation.

# Note:

Contact Oracle
Global Support for
assistance if the
import fails. This
parameter is for
advanced/internal
Support use only.
Operations such as
remap_tablespace
and remap_schema
should be added to
the file, each on a
separate line, with no
intervening spaces.
For example:
remap_tablespace=ol
dtablespacename:IN
FORM

remap_schema=olds
chemaname:newsche
maname

ignorederrors Optional path to text file containing list of errors to
be ignored during import.
This file is formatted as one error per line. The line
must exactly match (through case insensitive
comparison) the error for it to be ignored. Only
lines containing ‘ORA-* and ‘IMP-* are examined.

# Note:

Contact Oracle
Global Support for
assistance if the
import fails. This
parameter is for
advanced/internal
Support use only.
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Parameter

Description

resumelabel

Internal label to resume operations at.

# Note:

Contact Oracle
Global Support for
assistance if the
import fails. This
parameter is for
advanced/internal
Support use only.

log options

Optional parameters for specifying the log file name
and/or location.

The log file defaults to being named
ImportMigrationFiles.log.

The log file path defaults to the current working
directory.

Options:

* /LogFile:[filespec]

— filespec = fully qualified name and path for
created log file. If a relative path is given,
it is based from the current working folder.

—  Overrides the logfile-path to be the
resolved path to the given filespec.

—  Overrides the logfile-name to be the
resolved name of the given filespec.

— Do not specify this if either of the other
logging options are specified.

*  /LogFilePath:[pathspec]

— pathspec = fully qualified path to create
the log file in. If a relative path is given, it
is based from the current working folder.

—  Overrides the logfile-path to be the
resolved path to the given pathspec.

— Does not change logfile-name.

*  /LogFileName:[filename]

— filespec = Filename for the log file.

—  Overrides the logfile-name for the log file.

— Does not change logfile-path.

Command line prompts

If using prompting, you will be prompted for the following parameters:

Parameter

Description

InForm Study Name

Name of the Oracle InForm study you will create to
import the dmp file.

InForm Server Name

Name of the Oracle InForm server to run the study.

Study Schema Owner User ID

Study database schema owner user id for the
migrated study.

ORACLE
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Parameter

Description

Study Schema Owner User Password

Study database schema owner’s password for the
migrated study. Must conform to local password
requirements.

Original Study Schema Owner’s User ID

Study Schema Owner’s User ID from the source
environment. If not using a new User ID in the
migrated study, this can be left blank.

InForm Database Administrator User ID

Name for the Oracle InForm Database
Administrator.
Defaults to pfdbadmin if left blank.

InForm Database Administrator Password

Password for the Oracle InForm Database
Administrator.

Database Dump File Directory Path

Location on the Oracle InForm Database Server
where the dump file(s) are located. Must conform
to the Database Servers path format (for example,
path separators are \ on Windows, / on Linux)

Trial Database Dump Name

File name for the Trial Schema Database Dump
that is being imported.

Defaults to <trial-schema-owner-id>.dmp if not
specified.

Dump File InForm Version

The full version of Oracle InForm that the study
was exported from (for example, 6.2.1.0). Only
migrations from InForm 6.2.0.0 and up are
supported.

Trial Type

Study type for the imported study.

. LIVE
. UAT
« TRN
. DEV
- QA

Trial Approval

*  TRUE if you require approval for any
deployment package.

e FALSE if your study does not require
deployment package approval.

# Note:

The physical path
must exist before you
run the
ImportMigrationFiles
command.

ORACLE
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Parameter

Description

Deployment Backup Folder

Path on the Oracle InForm database server that will
be used for database recovery during study
deployment. Path must conform to the Database
Server OS Path format (for example, path
separators are \ on Windows, / on Linux).

For example /u01/app/deploybackup.

# Note:

The physical path
must exist before you
run the
ImportMigrationFiles
command.

Deployment Service Port

Port number for Central Designer to communicate
with the InForm application server to transmit
deployment packages.

Defaults to 14040 if left blank.

Auth Service Port

Port number for the InForm application server to
authenticate users for the Reporting and Analysis
module.

Defaults to 14041 if left blank.

ODM Service port

Port number for the Clinical Data API to exchange
SOAP requests through HTTP.
Defaults to 14042 if left blank.

InForm Adapter Schema Owner User ID

Oracle InForm Adapter Schema User ID if the
study is to be registered with Oracle InForm
Adapter.

Leave blank if not registering the study.

InForm Adapter Schema Owner Password

Oracle InForm Adapter Schema User Password if
the study is to be registered with Oracle InForm
Adapter.

Leave blank if not registering the study.

InForm Adapter Virtual Directory URL

Oracle InForm Adapter Schema Virtual Directory
URL if the study is to be registered with Oracle
InForm Adapter.

Leave blank if not registering the study.

InForm Publisher Trial Name from Source
Environment

Name of the study as configured with Oracle
InForm Publisher in the source environment.

May be left blank if the study is not being renamed
during the migration.

Path to InForm Publisher Configuration File

Path to the Oracle InForm Publisher configuration
file from the source app server if the trial is to be
registered with Oracle InForm Publisher. Leave
blank if trial is not to be registered with Oracle
InForm Publisher.

ORACLE
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Parameter

Description

Path to InForm Publisher Key File

Enter the path to the Oracle InForm Publisher
configuration Key file from the source application
server if the study is to be registered with Oracle
InForm Publisher.

Leave blank if the study is not to be registered with
Oracle InForm Publisher.

Parameter file contents

When using a parameter file, the path to a text file is given. The format of the parameter file is
parameter=value, with each value on a separate line, and no spaces between the parameter

name, =, and value.

The parameter file must contain the following parameters:

Parameter

Description

InForm_trial_name

Oracle InForm study name to create.

InForm_server_name

Name of the Oracle InForm server to create the
imported study in.

Trial_user

Trial Schema Owner User ID for the imported study.

Trial_user_pass

Password for the Trial Schema Owner User for the
imported study. Must conform to local password
requirements.

Pfdbapid

Oracle InForm Database Administrator Password.

Dump_file_dir_path

Location on the Database Server where the import
dump file(s) are located.

UpgradeFromIinFormVersion

The full version of Oracle InForm that the study
was exported from (for example, 6.2.1.0). Only
migrations from InForm 6.2.0.0 and up are
supported.

Trial_type

. UAT
. LIVE
« TRN
. DEV
« QA

Trial_approval

TRUE or FALSE.

Deployment_backup_folder

Path on the Oracle InForm Database server that
will be used for database recovery during study
deployment.

The parameter file may contain the following additional parameters:

Parameter Description

From_user Study Owner User ID in source environment if
different from trial_user.
Not needed if the Schema Owner User ID is not
being changed for the target Application Server.

Pfdbauid Oracle InForm Database Administrator User ID.

Defaults to pfdbadmin if not specified.
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Parameter

Description

Dump_file_name

Trial Schema dump filename.
If not specified, uses the default of
[trial_user].dmp.

Deployment_service_port

HTTP port number for Oracle Central Designer to
communicate with the Oracle InForm application
server to transmit deployment packages.

Recommended port is 14040. However, any port
other than 80 or 443 can be used.

Defaults to 14040 if not specified.

Auth_service_port

HTTP port number for Oracle InForm to
authenticate users for the Reporting and Analysis
module.

Recommended port is 14041. However, any port
other than 80 or 443 can be used.

Defaults to 14041 if not specified.

Odm_service_port

HTTP port number for the Clinical Data API to
exchange SOAP requests.

Recommended port is 14042. However, any port
other than 80 or 443 can be used.

Odm_service_port_https

HTTPS Port for the ODM service, no HTTPS
access if not specified.

IgnoredimportErrorsFile

Path to file containing list of import errors to be
ignored.

AdditionalParametersFile

Path to file containing additional import parameters.

AdditionalSchemas

Comma delimited list of additional schemas to be
imported.

Names are case sensitive and must match the
base name of the schema dump file that was or will
be copied to the database server.

Adapter_user

Oracle InForm Adapter Schema UID if study is to
be registered with Oracle InForm Adapter.

Adapter_user_pass

Oracle InForm Adapter Schema PID if study is to
be registered with Oracle InForm Adapter.

Adapter_Url

Oracle InForm Adapter URL if study is to be
registered with Oracle InForm Adapter.

Publisher_trial name

Study name as it appearsin the source Publisher
Configuration. May be left blank if the study is not
being renamed during import.

Publisher_configfile

Path to source Oracle InForm Publisher
Configuration file if study is to be registered with
Oracle InForm Publisher.

Publisher_keyfile

Path to source Oracle InForm Publisher
Configuration Key file if study is to be registered
with Oracle InForm Publisher.

Notes

Based on the parameters submitted when the command runs, the ImportMigrationFiles
command imports the Oracle InForm study database dump file, and performs study

configuration tasks, including:

e Creates the Oracle InForm server and study.
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* Upgrades the study schema.

e Updates study statistics.

e Sets the MedML Installer server.

*  Upgrades resources.

e Terminate obsolete users.

e Sets the deployment web service port.

*  Sets the Authentication service port.

e Sets the ODM service port.

e Configures Oracle InForm Adapter for the study.

e Configures Oracle InForm Publisher for the study.

grant_dba_privs.sql

Purpose

Grants DBA privileges to the rptinstall user, which is used for install and uninstall operations.

Location

Folder where the reporting software is located, for example,
<Installation_Directory>\InForm\bin\DBOra\Reporting.

Usage

@grant_dba_privs.sql rptinstall

Notes
Log on to the study database as SYSDBA.

The name of the DBA user must be rptinstall.

# Note:

The Oracle InForm database installation and administration scripts are designed to
be run using the Oracle InForm Application Server. The scripts can also be run from
the Oracle database home on an Oracle InForm Reporting Server. Running them
from a different Windows Oracle client or from a non-Windows Oracle client or
database home may work, but is not supported.

grant_user_privs.sql

Purpose

Grants database user privileges to the user that owns the study schema.

Location

Folder where the reporting software is located, for example,
<Installation_Directory>\InForm\bin\DBOra\Reporting.
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Usage
@grant_user_privs.sql <study schema owner>

<study schema owner>—Database user name that holds the study schema.

Example

@grant_user_privs.sgl pfst62uid

Notes
Run from SQL*Plus with /nolog.
Connect to the study database as a user with the privilege to grant user database privileges.

The script produces a log called grant_user_privs.log.

# Note:

The Oracle InForm database installation and administration scripts are designed to
be run using the Oracle InForm Application Server. The scripts can also be run from
the Oracle database home on an Oracle InForm Reporting Server. Running them
from a different Windows Oracle client or from a non-Windows Oracle client or
database home may work, but is not supported.

ImportUtility

ORACLE

Purpose

Securely import reporting content you export using Cognos commands to a new instance of
the Oracle InForm Reporting server.

Location

The Oracle InForm application server folder on the Oracle InForm application server. For
example, <Installation_Directory>\InForm\bin.

Usage
ImportUtility [-all | -import | -nopwd | -pfmtr]
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Option

Parameter

-all

Creates a secure staging folder on the
Reporting server accessible to system
administrators. The name of the staging folder
is Securelmport_<timestamp>.

Creates the import specification object on the
Reporting server accessible to system
administrators.

Imports the content from a password-protected
deployment package to the
Securelmport_<timestamp> folder and makes
it accessible only to system administrators.
Copies the imported content to the Public
folders on the Reporting server.

Deletes the Securelmport_<timestamp> folder,
all its content, and the import specification
object.

-import

Creates a secure staging folder on the
Reporting server accessible to system
administrators.

The name of the staging folder is
Securelmport_<timestamp>.

Creates the import specification object on the
Reporting server accessible to system
administrators.

Imports the content from a password-protected
deployment package to the
Securelmport_<timestamp>.

Deletes the import specification object.

-nopwd

Creates a secure staging folder on the
Reporting server accessible to system
administrators. The name of the staging folder
is Securelmport_<timestamp>.

Creates the import specification object on the
Reporting server accessible to system
administrators.

Imports the deployment package content to
the Securelmport_<timestamp> folder and
makes it accessible only to system
administrators.

Copies the imported content to the Public
folders on the Reporting server.

Deletes the Securelmport_<timestamp> folder,
all its content, and the import specification
object.

-pfmtr

Creates a secure staging folder on the
Reporting server accessible to system
administrators. The name of the staging folder
is Securelmport_<timestamp>.

Creates the import specification object on the
Reporting server accessible to system
administrators.

Imports the content to the
Securelmport_<timestamp> folder.

Deletes the import specification object.

ORACLE
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Command line prompts

Depending on the option you specify with the ImportUtility, you are prompted for the following
parameters:

« sysadmin_namespace—Cognos system administrator user namespace.
e sysadmin_uid—User name for the Cognos system administrator.
e sysadmin_pass—Cognos system administrator password.

e dispatcher_url—Internal URI that the Oracle InForm server uses to communicate with the
Cognos Analytics server.
This Cognos Analytics parameter is set in the Cognos Analytics Customization for Oracle
InForm wizard. The parameter setting is stored in the cogstartup.xml file and corresponds
to the Reporting internal URI value on the Admin > System Configuration page of the
Oracle InForm application. For example, http://example.com:9300/p2pd/serviet/dispatch.

- archive_name—Name of the deployment package containing the reporting content you
want to import into the Reporting server.

- archive_pass—Password for the deployment package.

# Note:

The archive_pass parameter is not required for the -nopwd or the -pfmtr option.

* cap_namespace—informcap.

e trial_uid—Owner of the study database schema.

« trialuser_pwd—Password for the owner of the study database schema.
e trial_name—Name of the Oracle InForm study.

 company_code—The organization ID. Optional.
This parameter is required only for Oracle-hosted studies in a single sign-on environment.

For legacy purposes, you can also pass the parameters by using the /
accountparams:‘path_to_parameter_file" command option.

When specified, this option includes the path to a text file that contains the values required to
run the command. The format of the parameter file is parameter=value. There is a new line for
each parameter, and there are no spaces on a line.

Notes

e The -import and -pfmtr command options should be used to stage custom reports before
distributing them to multiple studies.
To move the content from the staging folder to the study folders and set study-specific
permissions, use the pfmtrsetuputil command.

e The -nopwd and -pfmtr command options are used when you are importing a deployment
package that is not password protected.
These options should be used only when there is no clinical data present in the
deployment package.

Example

ImportUtility -all "E\scripts\import.txt"
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Informprepora

pfadmin

ORACLE

Purpose

Creates the pfdbadmin user if you did not set it up during the Oracle InForm core software
installation by selecting the Prep Oracle checkbox.

Location

<Installation_Directory>\InForm\bin folder.

Usage

informprepora <oracle_connection_string>

Command line prompts
You are prompted for the following parameters:

- dba user—Oracle account created during the Oracle database installation process.

- dba password—Password for the Oracle account created during the Oracle database
installation process.

e pfdbauid—Name of the Oracle InForm Admin database user.
- pfdbapid—Oracle InForm Admin database user password.

For legacy purposes, you can also pass the parameters by using the /
accountparams:‘path_to_parameter_file" command option.

When specified, this option includes the path to a text file that contains the values required to
run the command. The format of the parameter file is parameter=value. There is a new line for
each parameter, and there are no spaces on a line.

Example

informprepora trialdb

Purpose

Sets up the Oracle InForm server environment. The parameters are stored in the registry.
Therefore, you need local administrator privileges to run the utility.

Location

<Installation_Directory>\InForm\bin folder.

Usage

pfadmin [ CHECKREG | CONFIG | CREATEREPORTINGMODEL | HELP | KILLSERVER |
PING | PUBLISHREVIEWSCHEMA | RECREATEREVIEWSCHEMA | REMOVE |
RECREATEREPORTINGSCHEMA | RULESCANPROCESS | RULESCANVIEW |
SETSERVER | SETUP | SETLANGUAGE | START | STOP | UNINSTALL |
UPDATEWORKFLOW]| VIEW ]
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Option Purpose and Syntax

CHECKRERG [/Del] [/DelAll] Displays the current Oracle InForm Server COM
and MTS components in the NT registry.

WARNING:

Be careful to remove
the server(s) or
uninstall the service
before using either of
the delete options:

* [/Dell—Removes
obsolete
settings.

o [/DelAll]—
Removes the
settings of all
servers.
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Option

Purpose and Syntax

CONFIG Service

[/AdminDB DBServer ] |

[/AdminDSN DsnName | |
[/AdminDN ] |

[/EmailSender valid_email_address] |
[/PfUser ] |

[/SysDBA ]

[/HelpUrl URL of internal help site index.html page]

[/SearchUrl “https://docs.oracle.com/apps/search/
search.jsp?
category=industries&product=product_id&q="]

Configures an existing service.

[/AdminDB DBServer [SQL]]—Sets the ODBC
DSN for the InformAdmin database. Make sure
that DBServer, UID, and PID are the same
ones that were used to create the InformAdmin
database. Use alphabetic or alphanumeric
characters for the UID and PID, and begin
them with a letter; do not use all numeric
characters.

[/AdminDSN DsnName ]—Creates the ODBC
DSN Oracle InForm software with the default
database server, using the specified user
name and password. Use alphabetic or
alphanumeric characters for the UID and PID,
and begin them with a letter; do not use all
numeric characters.

[/EmailSender valid_email_address]—Creates
the PFMngrExecutionPlan registry key and
populates the EmailSender subkey with an
email address to use during autodeployment
notifications.

[/PfUser]—Creates the PfUser_computername
account during the Oracle InForm installation.
The account is for Microsoft MTS packages
used by Oracle InForm servers. In general,
you do not need to configure the account. If
you change the password through NT User
Manager, you must reconfigure the InForm
Service with the new password.

[/[SysDBA ]—Sets the Oracle InForm Service
DBA user name and password. You can use
this command to change the pfdbadmin
password as needed.

If you want to change the Oracle InForm
Service DBA name, modify the provided SQL
script InFormPrepORA.sqgl with the new user
name and password, then run the script as a
user with SYSDBA credentials. After running
the script, use this command option to
configure the Oracle InForm Service to use the
new Oracle InForm Service DBA.

Use alphabetic or alphanumeric characters for
the UID and PID, and begin them with a letter;
do not use all numeric characters

[/HelpUrl URL of internal help site index.html
page]—Changes the help link in the Oracle
InForm user interface so that it points to a local
URL instead of the default location on the
Oracle Help Center (OHC).

[/SearchUrl “https://docs.oracle.com/search/?
g=search_term&category=industries&product=
en%2Findustries%2Fhealth-
sciences%2Finform%?2Frelease—Changes the
OHC documentation library where searches
are performed from the search field in the
upper-right corner Help menu of the Oracle
InForm user interface.
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To update the Help location, refer to the User
Guide for Administrators

CONFIG Server ServerName
[Automatic|Manual]

Configures the startup mode for an existing server
as either Automatic or Manual.

CONFIG Trial TrialName
[Automatic | Manual] |

[/TriDSN DSN |

[/RndDSN DSN] |

[/Rnd [TNS_Service_Name ]] |

[/Host ServerName] |

[/TrialType [UAT | LIVE | TRN | DEV | QA]] |
[/TrialApproval [TRUE | FALSE]] |
[[TrialMaintenance [ON | OFF]] |

[/DeployBackupFolder
<"path_to_a_database_server_folder">]

Configures an existing study.

[Automatic | Manuall—Configures the study
startup mode.

[/TribSN DSN ]—Configures the study ODBC
DSN. Use alphabetic or alphanumeric
characters for the UID and PID, and begin
them with a letter; do not use all numeric
characters.

[/RndDSN DSN]—Configures the study to use
the randomization source dataset name.

[/[Rnd [TNS_Service_Name]—Creates a study
randomization source dataset name.

[[Host ServerName]—Moves the study from
current host server to another server in the
Oracle InForm Service.

[/TrialType [UAT | LIVE | TRN | DEV | QA]]l—
Specify the type of study. Live studies are for
production environments, UAT studies are for
user acceptance testing, Training, Dev, and QA
are for internal use.

[/TrialApproval [TRUE | FALSE]]—Specify
whether a deployment package needs
approval before it can be deployed to the
Oracle InForm application. By default, Live and
UAT studies are set to TRUE. Training, Dev,
and QA studies are set to false.
[/TrialMaintenance [ON | OFF]]—Specify that a
study is in Maintenance mode and is
unavailable to users. This is set during study
deployment.

[/DeployBackupFolder
<"path_to_a_database_server_folder">]—
Specify the path to an existing folder on the
database server. This folder is the location
used to store copies of the study database
during deployment package processing.

CONFIG CDD TrialName
[Enable | Disable] |

[DSN [Active | Inactive]] |
[DSN StudyLocale]

Configures an existing CDD:

[Enable | Disable]—Enables or disables the
CDD for a particular study.

[DSN [Active | Inactive]]|—Makes a CDD DSN
active or inactive for a particular study.

[DSN StudyLocale]—Specifies the study locale
used for the unit symbol translation that is
stored in the CDD column for the unit symbol.
path_to_dsn_password_file—Configures an
existing CDD DSN with the User ID and
password specified. Use alphabetic or
alphanumeric characters for the UID and PID,
and begin them with a letter; do not use all
numeric characters.
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CONFIG WEBSERVICE TrialName
[AuthService | DeploymentService |
ODMSubmitService]

[Add [HTTP:port | HTTPS:port cert:thumbprint] |
Remove]

Associates a web service with a study and

specifies the port number each service should use.

*  [AuthService | DeploymentService |
ODMSubmitService]—The type of service

* [Add [HTTP:port | HTTPS:port cert:thumbprint]
| Remove]—Creates or removes an
association between a study and a web
service

CREATEREPORTINGMODEL TrialName

Creates the Reporting model from scratch.

HELP

Lists all the options of the pfdamin command.

KILLSERVER ServerName

Stops server MTS packages without stopping
studies on the server.

PING MachineName
1| 2] 3:ServerName | 4:ServerName |
5:ServerName [Port#]

Pings the Oracle InForm Service or a particular

server. The ping levels are:

e 1—Ping the Oracle InForm Service.

¢ 2—Ping the Oracle InForm Service and all
Oracle InForm server(s).

»  3—Ping the specified server.

*  4—Ping and get information about the
specified server.

»  5—Ping the specified server and dump the
user session to a server-side file.

*  [Port#]—Allows you to specify the port number
the echo server is listening on, if you changed
it.

PUBLISHREVIEWSCHEMA TrialName [/FORCE]

Applies all study version changes to the review
schema clinical tables.

If you use the /FORCE option, the Oracle InForm
application does not check to see if there are study
version changes that are not applied, and makes
sure all study version changes are applied.

# Note:

The /FORCE option
does not drop and re-
create the clinical
tables. It makes the
clinical tables match
the study version.
The /FORCE option
should only be used if
recommended by
Oracle.

This operation is
synchronous. The
study is unavailable
during the operation.

ORACLE
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RECREATEREVIEWSCHEMA [TrialName
StudyLocale_ISO_name]

Recreates the review schema database tables from
the Oracle InForm schema. Depending on the size
of the study, this can take a long time to run.

The Review schema study locale is chosen

automatically when a study is first installed, but can
be changed using this command.

REMOVE
[Server ServerName] |

[Trial TrialName [/DSN]] |
[CDD TrialName [/All | DSN]

Removes an existing server, study, or CDD.

* [Server ServerName]—Removes an Oracle
InForm server from the Oracle InForm Service.
Studies should be either reconfigured to other
servers or removed before this command is
run.

e [Trial TrialName [/DSN]]—Deletes the named
study from the Oracle InForm Service. The
Web virtual directories and folders for the
study are physically removed. Use the /DSN
option to remove the study-related DSNs.

* [CDD TriaIName [/All | DSN]—Removes either
all CDD DSNs in the specified study or the
given CDD by DSN.

# Note:

Before using the
PFADMIN REMOVE
command, verify that
IIS is running.

RULESCANPROCESS StudyName

Scans existing rules and execution plans, and
outputs a list of rules that violate the allowed rule
objects list and marks the rules as valid or invalid.

RULESCANVIEW StudyName

Scans existing rules and execution plans, and
outputs a list of rules that violate the allowed rule
objects list. This is an informational scan only; it
does not mark rules as valid or invalid.
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SETSERVER
[Site TriaIName MachineName] |

[MedMLlInstaller TrialName MachineName] |
[Reporting TrialName ReportingUrl] |

[ReportingAN TrialName
AuthenticationNamespace] |

[ReportingUR TrialName UserRoot] |
[ReportingInt TrialName ReportinginternalURI] |
[pfreportinguserpw TrialName] |

[systempw TrialName] |

[TrialURL TrialName TrialURL

Changes the MedML and Site servers and sets the
Reporting configuration settings.

[Site TrialName MachineName]—Not
supported.

[MedMLInstaller TrialName MachineName]—
Not supported.

[Reporting TriaIName ReportingUrl]—Set
Cognos URL for study.

[ReportingAN TrialName
AuthenticationNamespace]—Set Cognos
AuthenticationNamespace for study.
[ReportingUR TrialName UserRoot]—Set
Cognos UserRoot for study.

[ReportingInt TrialName ReportinginternalURI]
—Set the internal URI that the Oracle InForm
server uses to communicate with the Cognos
server.

[pfreportinguserpw TrialName]—Run this
pfadmin command after the password for the
pfreportinguser is changed in the Oracle
InForm user interface to set a property used by
Reporting when it needs the credentials of the
pfreportinguser user for building the model.
pfreportinguser is the preferred studyuser to
run pfrinit to configure Cognos for each study.
[systempw TrialName]—Set the password for
the system user for the specified study. The
command also activates the system user.
TrialURL TrialName TrialURL]—Set the vanity
URL for the specified study. Enter the URL that
you use to access the study, including the
tenant name.

# Note:

The SETSERVER
command requires
that you set the
Default Authentication
Level property of the
Oracle InForm server
to Connect.

To set this property:

1. Select
Administrative
Tools >
Component
Services > My
Computer -
Properties.

2. Setthe Default
Properties -
Default
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distributed
communication
properties -
Default
Authentication
Level value to
Connect.

SETUP Server ServerName [Automatic] Creates a new Oracle InForm server in the InForm
Service.
*  [Automatic]—The server is automatically
started with the Oracle InForm Service.
Manual startup is the default.

SETUP Trial TrialName ServerName Creates a study on the given Oracle InForm server
[/DB OracleConnStr] | with the option to either create a new ODBC DSN
[/DSN TriDSN [Automatic] or use an existing one. The server has to be

created. The study startup mode is Manual by

default. Use the Automatic option to automatically

start the study when the Oracle InForm server that
hosts the study is started.

*  [/DB OracleConnStr UID PID]—Creates an
ODBC DSN TrialName with the given
ServerName, UID, and PID. Use alphabetic or
alphanumeric characters for the UID and PID,
and begin them with a letter; do not use all
numeric characters.

e [/DSN TriDSN UID PID [Automatic]]—
Configures the created study TrialName to use
the given study dataset name TriDSN, UID,
and PID. The study must be present in the
ODBC DSN. Use alphabetic or alphanumeric
characters for the UID and PID, and begin
them with a letter; do not use all numeric
characters.

# Note:

Before using

the /DSN command,
verify that IIS is
running.
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SETUP CDD RefName TrialName
/DB OracleConnStr DSN

[/TBSP OraTBSP] [Active] [NoSchema]

Sets up a new CDD DSN associated with the given

CDD refname. Use alphabetic or alphanumeric

characters for the UID and PID, and begin them

with a letter; do not use all numeric characters.

e [/TBSP OraTBSP]—Defines the Oracle
tablespace for the CDD schema.

*  [Active]—Specifies that the DSN is
transactional.

*  [NoSchema]—Indicates that no new CDD
schema should be created during setup. The
existing database is not touched. By default,
the user is dropped and the Oracle database
destroyed. Then, a new schema is created and
populated based on the RefName that defines
the schema.

# Note:

To execute this
command
successfully, the
study must be
started.

SETUP CDD RefName TrialName
/DSN DSN [/TBSP OraTBSP] [Active] [NoSchema]

Sets up an existing DSN associated with the given

CDD RefName. Use alphabetic or alphanumeric

characters for the UID and PID, and begin them

with a letter; do not use all numeric characters.[/

TBSP OraTBSP]—Defines the Oracle tablespace

for the CDD schema.

e [Active|—Makes the DSN transactional.

*  [NoSchema]—Indicates that no new CDD
schema should be created during setup. The
existing database is not touched. By default,
the user is dropped and the Oracle database
destroyed. Then, a new schema is created and
populated based on the RefName that defines
the schema.

# Note:

To execute this
command
successfully, the
study must be
started.

SETLANGUAGE
[IsoLanguageName]
| en-US | ja-JP |

Sets the Oracle InForm product locale language.
en-US and ja-JP are currently supported.
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START
[Server ServerName] |

[Trial TrialName]

Starts an existing Oracle InForm server or study.

*  [Server ServerName]—Starts an existing
Oracle InForm server by server name.

» [Trial TrialName]—Starts an existing study by
study name.

START
[Trial TrialName [/Design]]

Starts the study in design mode. This means you
can install study components that are not
completely designed (strict checking is not in
force). By default, the study starts in production
mode.

STOP
[Server ServerName [/Trials]] |

[Trial TrialName [/Anyway]]

Stops an existing Oracle InForm server or study.

*  [Server ServerName [/Trials]]—Stops an
existing Oracle InForm server by server name.
By default, a running server can be stopped if
there is no study running and no other
application connected to it. The Trials keyword
stops all running studies, and then stops the
server.

e [Trial TrialName [/Anyway]]—Stops the named
study. The Anyway keyword stops a study
regardless of any connections or HTTP
requests.

UNINSTALL

Removes all Oracle InForm servers and studies,
and then removes the Oracle InForm service
settings PfUser_computername and the MTS
library package.

# Note:

The Oracle InForm
service must be
running for the
command to work.
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UPDATEWORKFLOW Configures and performs the update workflow
[StudyName ['siteMnemonic"] [- process. ) _
UpgradeStudyVersion]] | *  [StudyName [siteMnemonic] [ -
[SetWFThreadsNumber StudyName yvggkrﬁgvispt?: g/e\gesrsmn]]—Trlggers the update
NumberOfThreads] | :

[GetWFThreadsNumber StudyName]

If a siteMnemonic is specified, the process is
executed only at that site, otherwise it is
executed at all sites. The siteMnemonic must
be enclosed in double quotes if it contains a
space.

If the flag -UpgradeStudyVersion is used, the
site is updated to the latest study version
before update workflow runs.
[GetWFThreadsNumber StudyName]—
Returns the current setting for the number of
threads used for update workflow for the study.
The default is 2.

[SetWFThreadsNumber StudyName
NumberOfThreads] —Sets the number of
threads processing the workflow update for the
study. The value can be set between 1 and 32.

Caution:

You should not adjust this setting
without input from Oracle Global
Support. If the performance of your
study deployment or study migration
is too slow (for example, timeouts
happen), contact Oracle Global
Support for assistance.
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VIEW Displays a monitoring list of all servers in the
[Languages] | [Service] | InForm service, all studies in servers, or all

RefNames for CDD DSNs configured for a study.
e [Languages]—Lists installed languages

[Trial TrialName] | without starting the Oracle InForm Service.
[CDD TrialName] | [Reporting TrialName] - [Service]

[Server ServerName] |

—  Lists all the servers and studies in the
Oracle InForm service.
—  Lists installed product languages as well
as the actual installed product language.
e [Server ServerName]—Lists each server by
server name and studies hosted on that
server.
e [Trial TrialName]—Lists a study by its name.
» [CDD TrialName]—Lists the RefNames for
each CDD DSN configured for the specified
study.
*  [Reporting TrialName]—Lists the current status
of Reporting.
—  States whether the study is configured for
Reporting.
—  Specifies the type of reporting setup, for
example samedb.
—  Specifies the reporting username.
—  Gives the date of the last Cognos model
update.
— Reports if the Reporting database is up-
to-date.
—  States whether Oracle streams are
working properly (if applicable).

Command line prompts
Depending on the options you specify, you are prompted for the following parameters:
For pfadmin setup or pfadmin config commands:

e uid—Oracle InForm study database user.
e pid—Oracle InForm study database user password.

For pfadmin setserver commands:

e pid—Oracle InForm study database user password.

Examples

Check the status of InForm Reporting:

pfadmin view reporting pfsté3

Check the status of InForm servers and studies on an InForm Service:

pfadmin view service

11-38



Chapter 11
pfcognosconfig

Start the demo InForm server:

pfadmin start server demo

Start the sample study:

pfadmin start study sample

Stop all studies running on the demo InForm server, and then stop the demo server:

pfadmin stop server demo /Trials

Set the password and activate the system user account:
pfadmin setserver systempw pfst63

Notes

Any arguments containing commas, equal signs, or spaces must be enclosed within double
quotes.

pfcognosconfig

ORACLE

Purpose

Configures an Oracle InForm study to work with Cognos Analytics. The PFCognosConfig utility
is a command-line alternative to the Oracle InForm Reporting Configuration Wizard.

PFCognosConfig can be run multiple times to change reporting parameters. If the reporting
study user password changes, PFCognosConfig.exe must be run to tell Oracle InForm about
the new password.

When PFCognosConfig is run multiple times for a study, each run after the first does not need
to specify all of the parameters; only the changed parameters need to be specified.

Location

<Installation_Directory>\InForm\bin folder.
Usage

pfcognosconfig ["path to password file"]
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Option Parameter

path_to_password_file When specified, includes the path to a text file that
contains the user name and passwords required to
run the command.

If the parameter file is not specified, the command
prompts for the required user names and
passwords.

The format of the parameter file is
parameter=value. There is a new line for each
parameter, and there are no spaces on a line.

Command line prompts

You are prompted for the following parameters:

e trialname—Name of the Oracle InForm study.
* log_file—Name of output log.

° namespace—informcap

* gateway_uri—External public URI that communicates with the Cognos Analytics Gateway
Services from an end user's browser.

e dispatcher_uri—Internal URI that the InForm server uses to communicate with the
Cognos Analytics server.

« root_folder—The top-level reporting folder for the company.

« reporting_samedb—True if the study and the Reporting database are on the same server.

e trial_web_service—Oracle InForm authentication web service URL.

« register_db_server—Study database user registered with Cognos.

« register_db_user—Password for the database user registered with Cognos.

« remove—When set to true, reporting is turned off for the specified study and clears all
reporting settings for the study.

Parameter file contents

The following parameters are required for the pfcognosconfig command password file:

Option Description

trialname=<studyname> Name of the Oracle InForm study.

# Note:

Use the same case
as when the study
was created by the
Oracle Central
Designer deployment
package.

log_file=<outputlog> Name of output log. Example: nocreatorgcap.log.
(Optional).
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Description

namespace=<cap_namespace>

Custom Authentication Provider (CAP) namespace.
Enter informcap.

gateway_uri=<gateway_uri>

External public URI that communicates with the
Cognos Analytics Gateway Services from an end
user's browser. This Cognos parameter is set in the
Cognos Analytics Gateway Customization for
Oracle InForm wizard. The parameter setting is
stored in the cogstartup.xml file.

Example: http://www.example.com:80(443)/
cognos/bi

dispatcher_uri=<dispatcher_uri>

Internal URI that the Oracle InForm server uses to
communicate with the Cognos Analytics server.
This Cognos parameter is set in the Cognos
Analytics Customization for Oracle InForm wizard.
The parameter setting is stored in the
cogstartup.xml file and corresponds to the
Reporting internal URI value on the Admin >
System Configuration page of the InForm
application.

Used when running command line utilities that
perform SDK operations, such as pfrinit and
DecomTrial.

Example: http://www.example.com:9300/p2pd/
servlet/dispatch

root_folder=/<content>/
<folder>[@name='<studyname>']

The top-level reporting folder for the company.
Default:

/content/folder[@name="'<studyname>']

reporting_samedb=<true | false>

True if the study and the Reporting database are
on the same server.

trial_web_service=<URL>

Oracle InForm authentication web service URL.
This is a required parameter.

register_db_server=<ServerName>

Name of the server in which the study is registered
with Cognos.

register_db_user=<UserName>

Study database user registered with Cognos.

register_db_pass<UserPassword>

Password for the database user registered with
Cognos.

remove=<true>

When specified, turns off reporting for the study

and removes all reporting-related settings for the
study. When you use the remove parameter, you
must also specify the following:

e study_name

e register_db_server

* register_db_user

* register_db_pass

Example

Example command-line with a complete set of parameters to set up reporting:

pfcognosconfig "E:\scripts\pfconfigparams.txt"

ORACLE
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Purpose
Performs the following tasks:

* Modifies the default Cognos Analytics capabilities to fit the Oracle InForm reporting
environment.

« Creates new Cognos Analytics groups that match Oracle InForm reporting requirements.

e Sets Public folders permissions so that only Publishers can write to this public area. Maps
study-specific reporting groups to the Cognos Analytics groups and roles.

e Creates study-specific data connection and set permissions so that it is restricted for the
use of study members only.

« Copies the Oracle InForm Trial Management package present in the InForm folder and
renames it as a study-specific package.

* Creates a study folder that contains all the standard folders and reports that point to the
study-specific package. Relative paths within reports will be modified to reflect the new
location.

« Validates all copied reports so that all successfully validated reports are syntactically
correct and able to run against the study-specific packages.

Location

The Oracle InForm Application Server folder of the server where the Cognos Application Tier
components are installed. For example, <Installation_Directory>\InForm\bin.

Usage

pfrinit [setupinform]

Option Parameter

setupinform When specified, configures the reporting
environment without a study. When migrating the
reporting environment to a new machine, run the
command with this parameter before you import
export packages.

Command line prompts
You are prompted for the following parameters:

« sysadmin_namespace—Oracle Directory Server admin namespace.
« sysadmin_uid—User name for the Oracle Directory Server admin namespace.
« sysadmin_pass—Password you chose when creating the crnsysadmin user.

* publisher_namespace—Custom Authentication Provider (CAP) namespace. Enter
informcap.

*  publisher_uid—Oracle InForm study user who is a member of the following Reporting
groups:

— Publishers.
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— Either Sponsor Users or Site Users.
« publisher_pass—Password of the Oracle InForm study user.

« dispatcher_url—Internal URI that the Oracle InForm server uses to communicate with the
Cognos Analytics server.

e trial_name—Name of the Oracle InForm study.
* reportdb_pass—Study PID.

* in_place_upgrade—Y/N. Indicate if the PFRInit command is being run as part of an in-
place upgrade (required for an in-place upgrade). For more information, see the Upgrade
and Migration Guide.

For legacy purposes, you can also pass the parameters by using the /
accountparams:‘path_to_parameter_file" command option.

When specified, this option includes the path to a text file that contains the values required to
run the command. The format of the parameter file is parameter=value. There is a new line for
each parameter, and there are no spaces on a line.

Note

The recommended Oracle InForm study user for running pfrinit is pfreportinguser. You can
change the password for this user using the Oracle InForm user interface as with any other
user. After you change the password, however, you must run the PFADMIN command, using
this syntax:

PFADMIN SETSERVER PFREPORTINGUSERPW <studyname>
When prompted, enter the pfreportinguser password.

This command sets a property used by Reporting when it needs the credentials of the
pfreportinguser.

For more information, see pfadmin.

Example

pfrinit "E:\scripts\init.txt"

PostDeployWorkaround.cmd

ORACLE

Purpose

Applies a workaround after a study deployment. If the operation is successful, the command
returns 0. Otherwise, it returns 1 to signal the error.

Location

Deployment root folder, as defined in the DeployRoot registry value under
HKEY_LOCAL_ MACHINE\SOFTWARE\OracleHS\InForm. By default, it is the InFormDeploy
folder on the drive where the InForm application is installed. For example: E:\InFormDeploy.

Usage

PostDeployWorkaround <Study_Name> <TNS_Service_Name> <Deployment_ID>
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Option Parameter
Study_Name Name of the study requesting deployment.
TNS_Service_Name Local Net Service Name for the remote database
service.
Deployment_ID Unique identifier for the deployment request.
¢ Note:

Workarounds should be used as a last resort during automated deployments, in order
to keep human intervention to a minimum.

PreDeployWorkaround.cmd

Purpose

Applies a workaround before a study deployment. If the operation is successful, the command
returns 0. Otherwise, it returns 1 to signal the error.

Location

Deployment root folder, as defined in the DeployRoot registry value under
HKEY_LOCAL_ MACHINE\SOFTWARE\OracleHS\InForm. By default, it is the InFormDeploy
folder on the drive where the InForm application is installed. For example: E:\InFormDeploy.

Usage

PreDeployWorkaround <Study_Name> <TNS_Service_Name> <Deployment_ID>

Option Parameter
Study_Name Name of the study requesting deployment.
TNS_Service_Name Local Net Service Name for the remote database
service.
Deployment_ID Unique identifier for the deployment request.
¢ Note:

Workarounds should be used as a last resort during automated deployments, in order
to keep human intervention to a minimum.

RequestTime.cmd

ORACLE

Purpose

Indicates if a future study deployment time conflicts with any conditions on the production
environment. If the system is not available or if resource intensive tasks are scheduled on the
production environment during the requested timeframe, the requested time is rejected (the
command returns 1). Otherwise, it is accepted (the command returns 0).
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Location

Deployment root folder, as defined in the DeployRoot registry value under
HKEY_LOCAL_ MACHINE\SOFTWARE\OracleHS\InForm. By default, it is the InFormDeploy
folder on the drive where the InForm application is installed. For example: E:\InFormDeploy.

Usage
RequestTime <Study Name> <Requested_Date> <Requested_Time> <Study_Type>

Option Parameter
Study_Name Name of the study to be deployed.
Requested_Date Local date on the Oracle InForm server when the

deployment is requested, in the format MM/DD/
YYYY. For example: 05/18/2017.

Requested_Time Local time on the Oracle InForm server when the
deployment is requested, in the format HH:MM. For
example: 15:30.

Study_Type Type of the study to be deployed. Options are:
. LIVE
. UAT
e TRAINING
. QA
. DEV
# Note:

The RequestTime command helps planning deployments that do not conflict with
scheduled maintenance windows or expected peak system usage periods. However,
it cannot prevent conflicts caused by conditions that were unexpected or
unscheduled at the time the request was made, such as emergency maintenance
operations.

11-45



Troubleshooting

In this appendix:

e Install issues

Install issues

In this seection:

* XA Views: INVALID

» Database connectivity

e Password error on Oracle InForm service start up

*  ORA-01792 error during reporting setup

e Could not register the COM object InFormRuleEngine

XA Views: INVALID

If you have tried the solution that is recommended in Oracle MTS configuration is invalid and
still get this error, or if you run mtsoral02 from the command line and get a warning, the
xaview.sql file may not be installed.

# Note:

This can happen for some Oracle client-only installations (multi-tier setup).

Possible solution:

1. Copy the xaview.sql file from another machine (running the same Oracle version) to your
Oracle rdbms\admin directory.

2. Login as a user with SYSDBA credentials on a machine with xaview.sq|l.
3. Run xaview.sql against your Oracle InForm core instance.

4, Run mtsoralO2 from the command line.

Database connectivity

If you get a warning about database connectivity, make sure that:

e The connect string value is correct.
e The pfdbadmin password is valid.

If you get a message that the pfdbadmin user does not exist, create the user by doing one of
the following:

* Select the Prep Oracle checkbox in the Oracle InForm installation wizard.
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* Run the informprepora command located in the InstallSupport folder of the Oracle InForm
installation image.

Password error on Oracle InForm service start up

The Oracle InForm installation wizard cannot ensure that the password entered on the Account
Configuration Window for the Local Machine User (pfUSR) meets the password requirements
set for the machine. If you enter a password that does not conform to the Windows password
requirements, an error will prevent the Oracle InForm service from starting.

1. To change the pfUser password enter the following command at a DOS prompt:

pfadmin install

2. When prompted for the pfUSR password, enter a password that meets the password
requirements.

3. Run the following command to start the InForm service:

new start pfservice

Use the pfadmin view service command to verify that the Oracle InForm service has started.

ORA-01792 error during reporting setup

Possible cause

Your study design includes a large form that requires more than 1000 columns to be created in
a table or view in the database.

Possible solution

Modify your study design to use forms with 20 or fewer items on each form. Limiting the size of
your forms can also prevent downstream issues in Oracle InForm, RDEs, and other integrated
applications.

Could not register the COM object InFormRuleEngine

When trying to deploy the study, if you run into this error open a command line, go into the
DesignerVersion folder in OracleHS\InForm\Bin and run registerruleengine.bat to fix it.
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Running the Cognos Customization wizards in
silent mode

In this appendix:

Run the Cognos Analytics Customization for Oracle InForm wizard in record mode
Run the Cognos Analytics Customization for Oracle InForm wizard in silent mode

Run the Cognos Analytics Gateway Customization for Oracle InForm wizard in record
mode

Run the Cognos Analytics Gateway Customization for Oracle InForm wizard in silent mode

Run the Cognos Analytics Customization for Oracle InForm
wizard in record mode

ORACLE

Run the Cognos Analytics Customization for Oracle InForm wizard to install the
customizations for the Cognos Content Manager Server or the Cognos Report Server.

For more information, see Run the Cognos Analytics Customization for InForm wizard—
Cognos Content Manager / Cognos Report Server.

Open a Command Prompt window, and use the following command to run the Cognos
Analytics Customization for Oracle InForm wizard in record mode.

This step records the installation options, and creates the setup.iss response file that you
can use to run the wizard again in silent mode, on other machines

Cognos_Analytics Customization for InForm\setup.exe -r

-fl<path to configuration files>\Cognos Analytics Customization for InForm\
setup.iss

Parameter Description

-r Runs the wizard in record mode. The options you
select when the wizard runs are saved in the
response file (setup.iss) identified by the -f1
parameter.

-f1 Identifies the location of the response file. There

is no space between the -f1 flag and the
response file location. For example:

-f1E:\Cognos Analytics Customization
_for InForm\setup.iss.
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Run the Cognos Analytics Customization for Oracle InForm
wizard in silent mode

Extract the Cognos_Analytics_Customization_for_InForm archive from the product archive
to a location that is accessible to the machines where you will run the wizard.

Populate the setup.iss file in the folder with the options you want to specify for the Cognos
Analytics Customization for Oracle InForm wizard.

You can edit the setup.iss files manually, or you can run the customization wizard in record
mode. For more information, see Run the Cognos Analytics Customization for Oracle
InForm wizard in record mode.

Open a Command Prompt window, and run the following command:

Cognos_Analytics Customization for InForm\setup.exe -s

-fl<path to configuration files>\Cognos Analytics Customization for InForm\
setup.iss

-f2<path_to configuration files>\Cognos Analytics Customization for InForm\
setup.log

Parameter Description
-S Runs the wizard in silent mode.
-f1 Identifies the location of the response file that

contains the options for the wizard. There is no
space between the -f1 flag and the response file
location. For example:

-f1E:\Cognos_Analytics Customization
_for InForm\setup.iss

-f2 Identifies the location of the log file for the
wizard. There is no space between the -f1 flag
and the log file location. For example:

-f1E:\Cognos Analytics Customization
_for InForm\setup.log

Run the Cognos Analytics Gateway Customization for Oracle
InForm wizard in record mode

ORACLE

Run the Cognos Analytics Gateway Customization for Oracle InForm wizard to install the
customizations for the Cognos Gateway Server.

For more information, see Step 1: Run the Cognos Analytics Gateway Customization for
Oracle InForm wizard on the Cognos Gateway Server.
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2. Open a Command Prompt window, and use the following command to run the Cognos
Analytics Gateway Customization for Oracle InForm wizard in record mode.

This step records the installation options, and creates the setup.iss response file that you
can use to run the wizard again in silent mode, on other machines

Cognos_Analytics Gateway Customization for InForm\setup.exe -r
-fl<path to configuration files>\Cognos Analytics Gateway Customization for
_InForm\setup.iss

Parameter Description

-r Runs the wizard in record mode. The options you
select when the wizard runs are saved in the
response file (setup.iss) identified by the -f1
parameter.

-f1 Identifies the location of the response file. There
is no space between the -f1 flag and the
response file location. For example:

-f1E:\Cognos_Analytics Customization
_for InForm\setup.iss.

Run the Cognos Analytics Gateway Customization for Oracle
InForm wizard in silent mode

1. Extract the Cognos Analytics Gateway Customization for Oracle InForm archive from the
product archive to a location that is accessible to the machine where you will run the
wizard.

2. Populate the setup.iss file in the folder with the options you want to specify for the Cognos
Analytics Gateway Customization for Oracle InForm wizard.

You can edit the setup.iss file manually, or you can run the customization wizard in record
mode. For more information, see Run the Cognos Analytics Gateway Customization for
Oracle InForm wizard in record mode.

3. Open a Command Prompt window, and run the following command:
Cognos_Analytics Gateway Customization for InForm\setup.exe -s

-fl<path to configuration files>Cognos Analytics Gateway Customization for
InForm\setup.iss

-f2<path_to configuration files>\Cognos Analytics Gateway Customization for
_InForm\setup.log

Parameter Description

-S Runs the wizard in silent mode.
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Run the Cognos Analytics Gateway Customization for Oracle InForm wizard in silent mode

Parameter

Description

-f1

Identifies the location of the response file that
contains the options for the wizard. There is no
space between the -f1 flag and the response file
location. For example:

-f1E:\Cognos Analytics Customization
_for InForm\setup.iss

Identifies the location of the log file for the
wizard. There is no space between the -f1 flag
and the log file location. For example:

-f1E:\Cognos Analytics Customization
_for InForm\setup.log
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Typical rights for CRA and CRC rights groups

In this appendix:

«  CRArights groups
e CRC rights groups

CRA rights groups

These are the typical rights associated with the CRA rights group:
e Print

*  Monitor

e Canned Reports

* View CRF

*  View Signature History for CRF

*  View Signature History for CRB

» Data Export Listings

* Freeze a CRF

* Unfreeze a CRF

e Mark and Unmark a CRF as SVed

e Change Site SV Settings

* Freeze a CRB

* Unfreeze a CRB

* Change Query State from Candidate to Open

* Change Query State from Candidate to Deleted
* Change Query State from Answered to Closed
* Change Query State from Open to Closed

* Change Query State from Reissued Candidate to Closed
* Enter Query in Candidate State

*  Enter Query in Open State

e Re-issue Query in Candidate State

e Re-issue Query in Open State

* Reordering of Patients

CRC rights groups

ORACLE

These are the typical rights associated with the CRC rights group:
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Print

Enroll Patients

View CRF

View Signature History for CRF
View Signature History for CRB
Enter Data into a CRF

Edit Data on a CRF

Enter Comments into a CRF
Mark a CRF as Ready for SV
Mark and unmark a CRB as Ready for SV
Answer Query

Reordering of Patients

Chapter 14
CRC rights groups
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